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Photo © Joe Farace

Photo © Rick Sammon

W
 henever my Uncle Benny walked into a

room and flipped on the light switch,

he always announced, "Let there be

light." Sometimes he used a more witty approach

and said, "Let me shed a little light on the subject."

Hey, it may be corny, but Uncle Benny was right

about one thing: We photographers would be lost

without light.

Technically speaking, when we take pictures we're

recording visible light on a piece of film or a digital

imaging sensor. That's why it's important to closely

observe a scene's lighting conditions before we

make a picture.

But what about invisible "light," such as infrared

radiation?
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One of my earliest photographic memories was watch-

ing my mother hand color a black-and-white picture.

For me, it was magical to see the picture's transforma-

tion from black and white to color. That's exactly how I

feel about digital infrared (IR) photography. If you want

to create pictures with a unique look, consider digital

IR. That's where this book and Joe Farace come in. Joe

will show you how to produce infrared images using a

digital camera as well as how to convert pictures that

were previously "straight" photographs.

Joe is my very dear friend and was technical editor for

several of my books, so he's the best guy to tackle a

technical subject like infrared photography. He has not

only written over twenty books on photographic tech-

nique and technology, but is also author of the "Digital

Innovations" column that appears regularly in

Shutterbug magazine.

But Joe is not a geek, and this isn't a geeky book; it's all

about having fun with digital infrared photography—

both in camera and in the digital darkroom. (Uncle

Benny liked to have fun, too.) One of the things I

admire about Joe's writing is his ability to make seem-

ingly complex techniques understandable to even a

beginning photographer. So buckle your seat belt, it's

going to be a fun ride. Let's travel with Joe down the

infrared highway.

Photo © Joe Farace

10 foreword



Photo Joe Farace
complete guide to digital infrared photography 11



"Results are uncertain, even among the most
experienced photographers." Mathew Brady
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Mathew Brady was probably referring to the

daguerreotype process, but he could have just as well

have been talking about infrared (IR) photography.

Creating digital IR images is not overly complicated,

but it does require a certain amount of knowledge

and practice. The element of surprise, however, is one

of the aspects that keeps digital infrared photography

fun and challenging.

I expect that you already know how to make a prop-

erly composed and exposed photograph, maybe even

using the camera's Manual exposure mode. This book

comprehensively explores digital infrared photogra-

phy. It therefore is not a primer on photography; you

can find that information in other Lark Book publica-

tions such as The Joy of Digital Photography and

Mastering Black and White Digital Photography.

Welcome to
the World of Infrared

Astronomers have long used the infrared spectrum

for astrophotography. There are also plenty of

scientific applications for terrestrial infrared photogra-

phy, including forensic investigation and aerial sur-

veys of crops or forests. But you did not buy this book

for those reasons. Part of the fun of photography is

trying new things. Digital IR photography helps you

look at your world in a new way and lets you create

otherworldly images that appear unlike those from

any other technique you're likely to try. That alone is a

good enough reason to try infrared digital photography.

Look at the photo on this page. The surprising tone

shifts and starkness, the ethereal white grass and

soft-looking leaves, the dark and brooding sky:

These are the hallmarks of black-and-white IR pho-

tography. This is an often invisible world made

possible by infrared recording techniques.

The first image was photographed in

full color. The second is a standard

black-and-white conversion, produced

with image-processing software. The

third is an IR photograph, which was

shot with a Canon digital SLR specially

modified for infrared photography.

Photos © Rick Sammon.
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Infrared color photographs often have a fairy-tale

look because colors are topsy-turvy. IR color film ren-

ders infrared-reflecting plants in orange to purple-red

tones, while the use of camera filters can suppress the

blue and green components that are also present. You

can work in the digital darkroom using software to

create IR color film effects.
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What is Infrared Light?

Technically speaking, infrared is invisible radiation

rather than light. I shall, however, sometimes refer

to "infrared light" in order to describe what your

camera is recording during the process of infrared

photography.

We normally use visible light to create photographic

images on digital sensors or film. What humans see as

red, orange, yellow, green, blue, indigo, and violet are

really different wavelengths of light. The waves get

longer as they approach the red portion of the spec-

trum. Every color's wavelength is measured in



As with all things related to digital IR, there are

many ways to accomplish what you want. Here, a

conventional, full-color image was shot in available

light with a Canon EOS digital SLR. Next, a "faux"

monochrome IR version of the image was created

with image processing software using techniques

that will be described later in the book. Finally, as

you will discover as you read through these pages,

true IR color can only be photographed using spe-

cial films such Kodak's Ektachrome Profession IR

slide film, but the effect can be simulated using

digital darkroom techniques as shown in the third

version of the photograph.

nanometers (nm: one billionth of a meter) or microns

(one millionth of a meter—sometimes the term mil-

limicron is used interchangeably with nanometer).

Red light begins at wavelengths of about 650 nanome-

ters. Violet light has wavelengths around 400 nm,

while yellow light waves are around 575 nm.

Immediately above and below the visible light spec-

trum are wavelengths that we cannot see with the

naked eye. Ultraviolet rays are shorter than violet

light, ranging from about four nm to 380 nm. Infrared

wavelengths of 700 nm are longer than visible red

(give or take a few nanometers). This marks the

beginning of the infrared spectrum, which extends to

wavelengths of one million nm. Though this band of

radiation is invisible to our eyes, it has some of the

same properties as visible light; for example, it can be

focused and reflected. And just like visible light, IR

wavelengths can be polarized.

We don't use the full spectrum of infrared radiation

for infrared photography. Our primary concern is the

range of IR wavelengths between 700 and 1000 nm-

closest to visible red. This near infrared (NIR) is the

range that is most readily recorded by the sensors in

today's digital cameras.
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This church was shot on Kodak Ektachrome Professional Infrared
film using a Nikon film SLR with a Nikon R60 red filter (which is
similar to a standard 25A red filter). The exposure was made by
setting the camera to ISO 200 and bracketing like crazy. Digital
technology has made IR photography much more convenient for
the average photographer, making the special handling required
for creating images with film virtually a thing of the past.
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A Note about Infrared Film

To better understand how digital infrared photogra-

phy works, let's first quickly consider the world of

film IR photography. You will then understand why

digital technology has made infrared photography

more accessible to amateur photographers than it

used to be.

Photographers have long used infrared films that are

not only sensitive to infrared radiation, but also to a

portion of ultraviolet and all visible-light wave-

lengths. These films gave photographers the ability to

make pictures with that special "IR look."

However, IR films are less stable than other photo-

graphic emulsions. Thus they are difficult to use and

process due to special handling requirements. You

have to unload your IR film in total darkness and,

most likely, process it yourself or find an

ever-dwindling pool of specialty labs to do it for you.

No such special handling is required with digital

photography: You can make prints directly from your

memory card.

What's in This Book?

First we will discuss how to capture IR images direct-

ly using a digital camera. Next we will look at how to

create the infrared look by converting digital files into

virtual (or faux) IR images in black and white or color.

This section will be as cross-platform as possible. A

recent version of Adobe Photoshop

was used to process most of the illustrations in this

book, but many other image-processsing programs

offer similar tools.

The "third half" (as they say on NPR's "Car Talk") of

this book is about what to do with IR images after

you create them. That's an important part of the fun

of IR photography.

So let's have some fun and make a

few digital IR images...
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Getting the
I mage on Your Sensor

"Get it on the negative." Leon Kennamer

Is Your Digital Camera IR
Sensitive?

Digital infrared photography is not merely an esoteric

pursuit, but one that is gaining in popularity as digital

technology takes over the field of photography. It is

an application that has the power to transform mun-

dane visual experiences into images that are unforget-

table. Ordinary scenes you might never think of pho-

tographing can take on a remarkable look in infrared.

If surreal color or dark skies with snow-white foliage

and increased contrast appeal to your aesthetic sensi-

bilities, IR is definitely for you.

And what the heck, digital IR is FUN!

Digital cameras are designed to make pictures using

visible light. But nearly all sensors (either CCD or

CMOS) used in digital cameras are sensitive to

infrared as well. However, because this sensitivity

could cause problems with color rendition, exposure

metering, and focusing, manufacturers usually place

a filter in front of the imaging sensor to prevent

excessive infrared light from striking it (but allowing

visible light to pass). These internal IR cut-off filters

(IIRC), often referred to as hot mirrors, protect the

image from color errors and desaturation without

reducing ISO speed.

The IIRCs fitted in today's cameras are not uniform

in their ability to stop infrared light from striking the

sensor. Consequently, some brands of digital cam-

eras (Fuji, Olympus, Sony, and some models from

Leica and Panasonic) have a reputation for transmit-

ting more IR light than others. Many compact digital

cameras from the earlier days (pre-2002) of digital

imaging are known for their IR capability. But that is

not to say that other, newer models cannot success-

fully shoot infrared images.
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These before and after shots show the power of infrared photography. The top image is a conventional color digital photograph and
the bottom is an IR photo of the same scene shot with a Nikon D1X and a Wratten #87 filter. Photos © Aaron Cathcart.
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If your digital camera is relatively sensitive to IR, you

can use a special IR filter on the end of your lens to

perform the opposite task of a hot mirror: The IR filter

will block visible light, thereby allowing infrared

wavelengths to pass through the lens to the sensor.

A strong IR capability is a feature that is often over-

looked when cameras are reviewed in the photo-

graphic press. So how do you know if your camera is

capable of photographing IR?
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Dust happens, especially in digital SLR cameras. It

accumulates on your sensor (or the filter that rests in

front of the sensor) during the normal process of chang-

ing lenses. You can minimize dust accumulation by

keeping your lenses clean and capped and by turning

off your camera before changing lenses so power to the

chip does not attract even more dust.

If you choose to remove internal dust on your own, use

a commercial tool designed for the task and follow the

manufacturer's instructions. Please note that some cam-

era companies warn about cleaning imaging chips

yourself and state that it may void your warranty. Thus

we recommend you proceed at your own risk.

If you still have dust, the safest thing to do is send the

camera back to the manufacturer for cleaning.

Test Your

Camera for IR Capability

Like everything in digital photography, equipment is

changing rapidly, so you'll need to test your own

camera to find it's potential to record infrared. How

do you do it?

Whenever I get a new digital camera, I give it the

"remote control test." What's that? One of the easiest

ways to check whether your digital camera is capable

of recording infrared images is to activate and point a

TV remote control at the camera and take a picture

(or look at the subject on the LCD panel of a digital

point & shoot).
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This digital IR image was recorded with a Canon EOS digital camera modified for IR photography.
It was photographed using the color mode setting. 1/125 second; f/8.0; ISO 200.

IR Conversions
When photographing the IR-emitting end of the

remote control in black-and-white mode (the best way

to do this test), you should see a point of white, the

brighter the better. If the camera does not record the

beam, it is probably not sensitive to infrared radiation.

If your camera passes the test, all you need to do is

get yourself an external IR filter or two to fit on the

end of your lenses. If your camera doesn't pass, you

can still find a way to create infrared images by get-

ting a converted camera.

There are several services that will convert certain

models into IR-only cameras. This process primarily

consists of removing the cut-off filter (IIRC) and

replacing it with a filter that blocks visible light.

Although expensive, a converted camera is highly

effective and convenient if you plan on shooting IR

frequently.

Once modified, your camera cannot be used for con-

ventional photography; it will be dedicated to IR pho-

tography. However, for avid IR shooters, an invest-

ment in a converted camera does offer advantages.

Since an internal filter is being used to block visible
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4

Here is the result when you convert to black and white with image-processing software.

light, there is no need to use a dark IR filter on the

lens. This is a big advantage for digital SLR shooters

because it is easier to view your subject to compose

and focus. Also, because the IIRC has been removed,

the camera is much more sensitive to infrared waves.

This allows you to shoot at lower ISOs and/or to set

shutter speeds fast enough to handhold your camera. In

contrast, a non-converted camera with a filter on the

lens almost always requires a sturdy tripod.

The converted camera will only record reflected IR

radiation, thus, for example it's not a thermal camera

that would allow you see how well the windows in

your home are sealed. The retrofitting may also set a

custom (called preset by some manufacturers) white

balance specifically for IR photography.

The filter used in a typical conversion is delicate

and cannot be touched. An optional "hardened"

filter may be available. This can be cleaned using

conventional means, and that's what I had installed

on one of my cameras.

For more information about this process, try a web

search for the term "IR camera conversion."
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This IR color image was recorded as a JPEG using an IR-converted
Canon EOS digial SLR. But I want the classic black-and-white IR
look for this photo. 1/320 second; f/8; ISO 200.

Open a duplicate TIFF of your JPEG in your

image-processing program.

_ I Open the Levels dialog window (Image >

Adjustments > Levels) and adjust as needed by drag-

ging black triangle just under the left edge of the

graph and the white triangle just under the right edge

of the graph. This isn't rocket science, so check the

Preview box and watch as you make these changes

until the image has the look you want.

Recording and Processing
JPEG Images for IR
Most digital cameras offer a choice of file formats in

which to record, often between JPEG and RAW (and

sometimes both simultaneously). Many photogra-

phers choose to shoot JPEG files because they take

less space on your memory card and often require

fewer steps and less time to process.

If your camera does not have a black-and-white

shooting mode, it will record a false color IR image.

Your IR JPEG images may need a few tweaks in your

favorite image-processing program to get them to

look the way you expect. There are several ways to do

this, and the following steps detail one of the quickest

and easiest methods.

The next step is to convert the file from RGB

to Grayscale (Image > Mode > Grayscale). Click OK to

discard the color information and create a file that

looks like a black-and-white IR photo.

This isn't the only way to accomplish a black-and-

white conversion, but it is the simplest. Other

methods, including the use of the powerful software

tools, are described in the chapter on Creating Digital

IR Images.
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A couple of quick image-processing steps converted the IR color JPEG original to black and
white. The depth of field would have been greater had I shot using f/11 instead of f/8, but the
photo still works for me (you can read more about focusing and depth-of-field considerations for

IR in the next chapter.)
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Recording and Processing
RAW Images for IR
A camera retrofitted for IR-only capability operates

just like an unaltered camera with a few exceptions.

You should only use the white balance setting provid-

ed by the folks who converted your camera because

this setting has been customized to make the images

as neutral as possible. (Instructions are usually

included with the camera to tell you how to reset it

if needed.)

In order to achieve optimum image quality, shoot in

RAW mode and save the images as 16-bit TIFF files.

However, Adobe Photoshop currently does not recog-

nize the modified white balance provided in convert-

ed cameras, so you will need to make adjustments in

Camera RAW, an Adobe plug-in that allows you to

work on RAW-format files and import them into

Photoshop at their maximum quality. (These sugges-

tions apply strictly to Camera RAW 3.0. and higher—

earlier versions may be slightly different, but the

screenshots provided here should give you an idea of

where and how to move each slider to achieve the

final result.) This series illustrates what you need to

do to achieve the Freaky Friday look of a mono-

chrome IR image.

Step 1: Open the image file in Camera RAW via

Adobe Bridge (File>Open in Camera RAW).
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Here is the final monochrome IR picture processed from a RAW file. A color depth of 16-bits is a good idea to
make the most of an image file from a modest three-megapixel camera, such as I used for this picture. (But as you
can see from the Depth drop-down menu in the preceeding screen shots, I don't always follow that advice!) 1/125
second; f/11; ISO 200.

complete guide to digital infrared photography 27



Brody Dezember is a professional photographer who

works in the Salt Lake Valley of Utah. He specializes

in photojournalistic-style wedding photography and

often shoots infrared to add a dramatic or dream-like

quality to his images. A self-described "computer

junkie," Brody was the one of the first photographers

in the state of Utah to implement an all digital studio.

Brody's website (www.dezemberphoto.com) features

a sophisticated portfolio of posed and candid wed-

ding and portrait work, and includes examples of his

black-and-white infrared photographs. It also offers

information on IR camera conversions.
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Focusing
and Exposing in IR

"Mysteries lie all around us, even in the most
familiar things, waiting only to be
perceived." Wynn Bullock

There are an infinite number of creative possibilities when work-
ing with digital IR. This picture was shot using an IR-converted
digital SLR. The sepia toning and water effect were added using
i mage-processing plug-ins.

Infrared photography is different in many ways than

traditional photography. Aside from recording a sepa-

rate segment of the energy spectrum, modifications in

equipment are needed, shooting techniques are dif-

ferent, and clearly, the results take on a look entirely

their own.

For instance, IR reflectivity is affected by many fac-

tors, including the temperature and time of the day.

With experience, you will look at the window and say,

"This is a great day to make IR pictures." Conversely,

you'll know when it's a waste of time to shoot

infrared because conditions are not right. Often it

seems that when the lighting is perfect for traditional

photography, it is probably a bad day to make IR pho-

tographs. But I like to say, the only rule is "there are no

rules," so explore every possible condition. And make

notes about them with each image using the captioning

capability of your image-processing program.

There are also several technical ways that infrared dif-

fers from traditional photography. Important among

these are how IR affects focus and exposure.
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Focusing Differences
Focusing for IR photography can be a challenge .. .

but only if you want to make it one. You may be sur-

prised to learn that even the various wavelengths in

the visible color spectrum do not focus on exactly the

same plane when passed through a lens. Much like a

prism, glass lens elements produce a rainbow of color

as light passes through them. This difference in the

optical behavior of various wavelengths of visible

light is called a chromatic aberration. Over the years

the optical engineers at the different lens manufactur-

ing companies have devised formulas and coatings to

correct the many types of chromatic aberrations.

Lenses described by terms such as achromatic, apoc-

hromatic (APO), super apochromatic, and ED glass

accomplish this in one way or another.

Most lenses, however, aren't chromatically corrected

for IR wavelengths and thus can't focus infrared

wavelengths on the same plane as visible light. That's

why it may be necessary to adjust the point of focus

slightly when shooting infrared images. You might be

interested to know that for most photographic lenses,

this shift is approximately 1/400th of the lens' focal

length, but I'll show you less mathematical ways to

make sure your IR photos are in focus.
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Depth of Field Scale

After you pick an aperture, such as f/16, rotate the focusing

ring so that aperture (f/16) on the depth of field scale is

opposite the infinity mark. On the lens below, this gives a

depth of field from about 14 inches (between .3 and .4

meters, or about 36 cm) to infinity—more than enough to

take care of any focus shift caused by infrared wavelengths.

Focusing with Digital SLR Cameras

In the past, many manufacturers of SLR lenses placed

an infrared mark on their products to help you make

this focusing adjustment. If present, it is usually indi-

cated by a red dot or an 'R' on the focusing index, or a

curved red line on zoom lenses. This is helpful if you

are using such a lens on a non-converted digital SLR

that lets you manually focus. Unfortunately, most

manufacturers no longer put an IR focus mark on

their lenses.

If this focusing mark is on your lens, here's how to

use it: Before the IR filter is in place, focus normally.

Then rotate the lens' focusing ring so the focused dis-

tance appears opposite the infrared focusing mark.

Attach the IR filter and shoot.

What about those of you who do not have this type of

equipment? Are you tossed out of the IR focusing

game? Fear not young padwan, help is on the way.

Hyperfocal Distance

Another way to deal with IR focusing is to use the

hyperfocal distance. This is my favorite method, espe-

cially when working with wide-angle lenses. It uses

depth of field to your focusing advantage.

Though technically there is only a single plane of

sharp focus in a photograph, in actuality there is a

space in front of and behind the plane of optimal

focus that is acceptably sharp. This is the depth of

field. When you focus on a subject, a rule of thumb

states that this area of depth of field extends from

one-third the distance in front of your subject to two-

thirds behind.

Imagine that you have focused your lens on infinity.

There will be a range in front of infinity that will also

be in focus. The closest point to your camera that is

32 focusing and exposing in IR

Some lenses, including this Canon EF 50mm f/2.5 Compact Macro
AF lens, have an IR mark for manual focusing. When shooting IR
with an opaque filter, set focus before attaching the filter. To do
so, focus manually, then set the focused distance opposite the
lens' red IR indicator. Finally, attach the filter and shoot.

still acceptibly sharp is known as the hyperfocal dis-

tance. Consequently, any object that is between this

point and infinity will also be in focus.

Your goal in using the hyperfocal distance is to maxi-

mize the size of this area of depth of field. If you set

focus at the hyperfocal distance instead of infinity,

you will achieve the greatest depth of field possible,

making it extend from half the hyperfocal distance to

infinity. This gives you the greatest odds of insuring

your subject is in focus.



This photograph was made with a Canon EOS digital SLR that has been converted to IR use.
The lens was set at the hyperfocal distance for f/11. 1/250 second; ISO 400.
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It's not easy to know the precise hyperfocal distance

for any given situation. It is variable depending on

the f/stop and focal length you are using, as well as

the size of the sensor in your digital camera. The tech-

nique is easier to use if your lens has a scale on it for

depth of field (a once common feature that is also get-

ting more difficult to find on modern SLR lenses).

Since more and more digital SLRs and almost all other

digital cameras are designed with lenses that have no

apertures or depth-of-field scales on them, you will

have to develop a sense of where the hyperfocal dis-

tance lies based on precalculated charts.

Use the chart above to determine the approximate

hyperfocal distance in feet or meters from your camera.
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This MC Zenita 16mm f/2.8 extreme wide-angle lens was manufac-
tured for film SLR cameras, but it works great with my converted
digital SLR too (although it must be manually focused). I prefer to
set it at f/16 (or something similar) and then set infinity across from
that aperture on the lens' depth-of-field scale. This keeps it in
focus from a fraction of a meter to infinity. I never focus the lens.
When it's mounted on my converted Canon EOS digital SLR, I treat
the combo just like a digital point-and-shoot camera.



IR-Converted Digital SLRs

To account for the back focus change resulting from

the removal of the IIRC, the advice from those who

make these conversions is to set the aperture at f/11

or smaller. Shooting at small apertures should not be

a problem because there are no filters to shoot through

when using an IR converted digital SLR.

IR-Converted Advanced
Compact Zoom Digital Cameras

Some of these cameras have manual exposure modes

that allow you to set the lens aperture; if your camera

has this feature, set the smallest aperture available

(largest f/number). Sometimes this is only f/8, which

may not seem like a large number in comparison to

SLR standards. But don't let that stop you from hav-

ing fun, it is still enough to give adequate depth of

field. The ability to stop down farther is often not

needed on these cameras, and most of your images

won't be intense close-ups anyway.

Focusing with
Non-SLR Digital Cameras

My IR shooting technique with these types of cameras

is so simple you might call it point-and-shoot

infrared. It is important to use a tripod since IR filters

are quite dark (see the next chapter for the scoop on

ilters), making it nearly impossible to get a sharp

handheld exposure. When shooting on a support, I

pick an exposure mode based on environmental con-

litions. Windy days call for Shutter Priority (Tv).

Most other times I simply use Program (P) mode, to 

 keep things simple.Of

course, using the hyperfocal distance is one way to get

 sharp focus with these cameras. If the camera has

 an electronic viewfinder (EVF), I first compose and      

 place the filter in front of the lens, then wait for the

mage in the EVF settle down and compensate for the

ilter's density. You can see the IR effect in the EVF or

CD preview screen.

 You might think that the image passing through an IR

 filter may be too dark or lack contrast for the camera

 to focus, but EVF cameras snap readily into focus. So

 if you have an EVF camera, let it focus through the fil-

er. If the camera has a black-and-white mode, I use

 that to get a real preview of the final image.
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Exposing for Infrared
Wavelengths
Because exposure meters are not sensitive to infrared

wavelengths, it becomes difficult to calculate exact

exposures. But there are ways to get properly exposed

digital IR photographs, especially with digital cameras.

Digital cameras provide instant feedback about the

shots recorded on your memory card. Not only can

you use the LCD screen to review the picture you've

just shot for brightness, but many digital cameras also

let you use it to review the histogram, giving you

accurate information about how over- or underex-

posed the picture might be (see page 38). You can

often reshoot a picture using different settings or

exposure compensation if you determine the exposure

is not acceptable.

Bracketing

Another method to help with infrared exposure is

bracketing. This means you make several photo-

graphs (in this case, three to five is sufficient) of the

scene, changing the exposure each time. Most digital

SLRs offer a built-in bracketing function that will

make a specified series of shots at exposures over and

under what is considered normal. Read your manual

for directions because every camera is a little differ-

ent. Even if your camera doesn't have a bracketing

function, it should have an exposure compensation

feature that will let you adjust exposures in incre-

ments of one-half or one-third (my preference) stops

while in the various automatic exposure modes.

The series of pictures on the opposite page illustrates

bracketing. Which of the shots in the bracketed series

is the "right" one. Here's the good news: It doesn't

matter. Whatever one you like best is the right one.

Don't ever forget they are your pictures, so you have

nobody else but yourself to please.

ISO Settings
With digital IR photography, one of the best exposure

techniques you can try when getting underexposed

shots is to increase the camera's ISO setting. This also

increases noise, giving the image a more "IR film"

look, which you may or may not like. The trade-off is

increasing aperture size (smaller f/numbers), but

there you have to do a delicate balancing act between

exposure, depth of field, and possibly losing focus on

an important part of the image.

Manual Exposure Mode
If all else fails, many digital SLRs offer a Manual

exposure mode. You don't need a hand-held exposure

meter to get started in Manual mode. Typically I will

determine what the suggested exposure is in Program

mode, then transfer that shutter speed and aperture to

the camera after it's set in Manual mode. Now you

are free to change the shutter speed or aperture to

bracket exposures.
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Bracketing Your IR Photos

This is the original scene before I shot a bracketed series of infrared photographs. The same camera and lens were used,
only the exposure and color mode were changed. 1/640 second; f/9; ISO 400.

This series demonstrates the bracketing method used to achieve a properly exposed IR image. I began by first setting the
camera to black-and-white mode and mounting a Cokin P007 filter in front of the lens. The Olympus digital SLR used for
this series automatically makes three different consecutive exposures by changing the shutter speed when it is in Aperture
Priority mode.

The second and third bracketed shots were made at slower shutter speeds as exhibited by the decrease in sharpness of the
leaves (compared to the first photo), caused by the wind moving them slightly. So what can be done? Switch to Shutter
Priority mode to increase shutter speed or move the ISO setting up. Or maybe you like the blur, so what the heck.
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The Proper Exposure

After bracketing a series of images or using your cam-

era's exposure system to set plus or minus compensa-

tion values, the next step is to determine which image

has the best exposure. You can use your digital cam-

era's LCD screen to look at the images and determine

if you need to continue making adjustments to the

exposure. But my favorite method involves using the

histogram that's built into your camera, probably

somewhere in its "INFO" mode. (This will vary with

each camera. Read your camera's manual to see if

your camera has a histogram and how to review it.)

If you're not familiar with a histogram, don't worry.

It's not something the night nurse will be bringing in

during a stay at the hospital. In statistics, a histogram

is a graphic representation of tabulated frequencies. In

digital photography, it's a display of the tones in the

i mage file, ranging from the darkest shadow (the left

vertical axis of the graph) to the brightest highlight

(the right axis of the graph). Traditional darkroom

practitioners might think of it as a digital Zone

System with Zone Zero at the leftmost part of the his-

togram and Zone X at the extreme right.

Generally, proper exposure is indicated by a his-

togram when the graph starts at the intersection of the

left vertical axis and horizontal base. The graph will

then curve up and down somewhat through the mid-

dle tones, and will end just at the intersection of the

horizontal base and the right vertical axis. If the graph

butts up to either the left or right vertical axes, so that

it falls straight down like a cliff, you will see 'clipping'

in your image, or loss of detail in the shadows (left

side clip) or highlights (right side clip).

Shadow details will be lost when the graph falls
straight down the left axis.

ms example of a histogram  snows copping m highlight
details as the graph falls straight down on the right axis.

This example demonstrates no clipping of shadow and virtually
none in highlight detail.
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This histogram is from an exposure made with an IR-converted
digital camera. The space between the end of the graph and the
right axis indicates that no light tones were recorded in the pic-
ture. (It is important to note that there is almost always a lot of
highlight areas in a landscape-type IR picture because deciduous
green plants appear white, remember?) Usually the histogram for
a properly exposed image ends just at the right axis.

Here is a histogram as it appears in the Levels option
(Image > Adjustments> Levels) in Adobe Photoshop. It
displays data in a similar way as the camera's his-
togram; and like the example from the camera above,
it is also underexposed. You can attempt to fix the
underexposure by moving the right triangle so it sits
just under the end of the right edge of the data curve.

There are two ways deal with histograms: One while

shooting, by looking at the histogram on the camera's

LCD screen; and the other later, when viewing the

image on your computer monitor in an image-pro-

cessing software program.

Using the camera's histogram allows you to review

your picture and reshoot on the spot if required. If the

histogram indicates underexposure, you can make

adjustments to optimize the image, most typically by

applying plus exposure compensation or by using

Manual (M) exposure mode to increase the exposure.

Be warned that sometimes you will increase exposure

and the histogram won't change. That's the nature of

IR, and it often varies from scene to scene because

some subjects that look quite bright to your eye may

be dead in terms of infrared content. In that case, con-

tinue to make increasingly stronger exposure adjust-

ments until you see a change, then stop.

However, like nearly all photographic tools, his-

tograms are not the Dead Sea Scrolls. Don't let them

rule your life. They merely give you an idea of where

to go with exposure. And get this: Sometimes the IR

content of an image is zilch. In that case, it's like tak-

ing a color picture of a black horse in a field of snow.

No matter how hard you try, you're not going to

make it have much color. For the most part, you

should be able to increase exposure to get data in the

right-hand side of the histogram. But remember, we are

applying the rules of visible light to invisible light and

they don't always translate as neatly as we might like.

 I believe it is always best to create the most optimal

image possible in-camera rather than depending on

image-enhancing software to "fix the image" later

after downloading. But I leave this for you to prove to

yourself; and besides, sometimes it is hard to see that

little LCD screen in bright daylight, so maybe you

don't know enough to make adjustments in the field.

You may need to enhance the file with image-process-

ing software anyway. That may not an ideal solution,

but it's a solution. That's why they call it art!
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When I gazed at this scene, it struck me as rather boring. But the trees had potential so I tried to visualize how they would look if shot in
infrared. 1/800 second; 1/10; ISO 400. A plus one-stop exposure compensation was used because of the backlit nature of the scene).

The picture looked more interesting when I previewed it in IR with a Cokin IR filter on the lens, so I photographed it at 1/25 second, f/3.6,
ISO 400 (right, top). A plus one-stop exposure compensation was used.

My camera has a sepia mode, so just for the heck of it I switched it on and created what I think is the most interesting photograph of the
bunch (right, bottom). Who knew? That's why you should never hesitate to experiment. With digital, you can always erase the clunkers. 1/10
second; f/3.6; ISO 400. A plus one-stop exposure compensation was used.

Seeing in Infrared

Photography is usually all about lighting, but IR pho-

tography is concerned with invisible wavelengths,

which is why comparisons to conventional photogra-

phy are difficult. If you want to create a dramatic

image, few things can beat a beautiful sunrise pho-

tographed in color. The same scene photographed in

IR may be disappointing unless there is some great IR

reflective subject matter (we're talking about big

deciduous trees here) to add interest. The "special

wood" effect (bright to white reproduction of the

chlorophyll layer of deciduous plants in black-and-

white images) appears strongest at low sun levels.
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It was a dark and stormy day. A plus two-stop exposure compensation was applied based on my assessment of
the preview image in the camera's LCD. 1/200 second; f/10; ISO 800.

Backlighting, long a favorite of photographers, often creates dramatic images—both conventional and IR. this picture was shot with a
converted Canon LOS. A plus one-stop exposure compensation was applied based on observing the camera's histograms of test expo-
sures. 1/200 second; f/9; ISO 400.
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If the lighting looks great for standard photographs,

such as portraits in the shade, or sunrise and sunset,

the rule of thumb is that it's probably not going to

work for IR. But don't take my word for it—you need

to experiment for yourself because you'll never know

for sure what the results will be. For example, see the

illustration opposite of the farmhouse surrounded by

trees. Shooting an approaching storm often makes a

great "standard" photograph. But I had a feeling that

I could make a dramatic digital infrared image as

well. The trees should retain some IR reflectance via

heat and the storm clouds should add impact, right?

Sometimes when you experiment you get lucky, and

that's what happened in the middle of a summer day

when I was taking my daily walk.

Really, there are no 'official' subjects for digital IR pho-

tography. Sure, summer landscapes with leafy trees, lots

of grass, and puffy clouds often make a great infrared

picture. But don't be confined to basic landscapes.

Some of the artists profiled in this book like to shoot

people in IR. Take a look at some of their portraits. I

li ke to photograph cars, so I made this picture of two

classic Jaguars.

I used the hyperfocal distance to insure sharp focus and

set exposure compensation at plus 1 - 1 /3 stops to make

the whites sparkle. 1 /1 6 second; f/16; ISO 200.

Any subject is fair game if you want to produce I

images. As I keep advising, experiment to see what

works. You may be surprised at the variety of subject

matter you can find for IR photographs.
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Paul Nuber of Fort Collins, Colorado is a part-time

professional portrait photographer whose work

includes shooting weddings, families, high-school

seniors, and models (www.pozim.com). Most of his

customers buy traditional portraits, but when shoot-

ing for his portfolio, Paul likes to experiment. "I

tried B&W infrared film a few times, and liked the

effect," he told me, "but it was hard to previsualize

the results and difficult to expose correctly."

In 2000 Paul bought his first digital camera, an

Olympus C2020Z. When he attached an IR filter and

turned on the LCD display, things became clear: "I

could see the world in infrared!" It was a quantum

leap from film. Paul says, "I shoot infrared because it

creates an image with recognizable shapes but unfa-

miliar tonality. Some parts of the image look normal,

yet other parts don't. I enjoy the contrast of black sky

and white foliage."
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For this autumnal photo, Paul describes the setup as follows: "I selected this setting for the light leaves on the
ground, the dark tree trunk, and the interesting sky, positioning myself about 45 degrees off axis with the sun. I
asked the model to face the sun for best lighting. The sun is low in the sky, which reduces its brightness and allows
it to light up her eyes. I try to shoot IR in direct sun, because it keeps exposure times short enough for the model
to hold still, and it keeps the light foliage from going gray." 1/30 second; f/2.2, ISO 200. Photo ©Paul Nuber.
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Infrared Filters
"I really believe there are things nobody would see if
I didn't photograph them." Diane Arbus

Digital sensors are designed to imitate the response of

our eyes to visible light, but infrared photography is

about recording non-visible wavelengths. (Remember

that the spectral range where red wavelengths are no

longer visible starts at about 700 nm, give or take a

few nm.) In order to record infrared photographs,

those visible light wavelengths below 700 nm must be

blocked so that they don't reach the sensor. Which

brings us to filters. If you shoot with a digital camera

that has not been converted to IR-only, you will need

to use a filter to create infrared photos.

How Do Filters Work?

It is a misconception to think that a colored filter adds

its color to an image. This is not the case. When used

in traditional photography, colored filters transmit

wavelengths that are a similar color to the filter and

block ones that are not. For example, in traditional

color photography, a blue filter that's used to color-

correct photographs made under incandescent light

does not actually add blue to the image. It subtracts

the red and yellow tones, rendering the image more

neutral in appearance. Depending on the density of

the blue filter, it blocks more or less of these other col-

ors. In much the same way, the various deep red

(becoming almost black) filters used for infrared pho-

tography totally or partially absorb or subtract visible

light while allowing the transmission of infrared light.

The information in this chapter is about using filters

to produce monochrome or black-and-white IR

images. (Black-and-white images are monochrome,

but not all monochrome images, as you will see

throughout this book, are black and white.) Images

captured by all of the methods suggested in this book

start as RGB (color) digital files and have to be

processed to make them appear monochromatic.

(Even when you use a camera's black-and-white

mode, the sensor is still recording RGB information—

the camera then has to process that image to make it

black and white.) Creating IR color images is a "faux"

process that requires creative postproduction tech-

niques, covered in more detail in subsequent chapters

of this book.

So what kind of filter do you need for your digital

camera?
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This infrared photo was shot using a conventional digital SLR equipped with a Hoya R72 filter. An
exposure compensation of plus one stop was used after reviewing a test shot on the LCD screen.
1/8 second; f/5.1; ISO 100.
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Filters for IR Photography
Filters have a long history of use in photography for

both practical and creative purposes. In this guide,

however, we are concerned with filters that specifical-

ly absorb or reflect visible light, allowing you to

record the infrared spectrum. The classic IR filter is a

round piece of glass within a metal or plastic mount

that allows it to be threaded on the front of a lens.

These are sold in various sizes to mount directly onto

different sized lenses. A quality filter is made of fine

optically flat material mounted within a frame that's

strong, durable, and not prone to binding or cross

threading. This takes precision manufacturing, which

is why a good filter can be expensive (but will last a

lifetime if well cared for).

Filters come in many different shapes, sizes, and

materials, including delicate gelatin filters that drop

into holders or lens hoods, round glass filters, and

square or rectangular glass or optical-plastic ones that

fit into modular holders.

The modular concept was popularized by Cokin,

whose system includes a holder that attaches to the

front of the lens with an adapter ring. The system's

square filters slip into the holder. Though you may

need different sized attachment rings to fit your vari-

ous lenses, you won't have to buy a different IR filter

for each lens because the same holder and filter can be

used with different sized adapter rings. On the down-

side, since the filter is not physically threaded into the

front of the lens like a screw-in type, visible light can

also enter from the sides, polluting the finished image.

Is this a good thing or a bad thing? Depending on your

desired effect, it's a little of both.

Semi-Famous Filter Facts

Many filters have a number designation based on a

system of tolerances first developed by Frederick

Wratten, who pioneered the use of colored filters at
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the beginning of the 20th Century. His company,

Wratten and Wainwright, made photo materials for

the commercial printing industry. He had established

his filter numbering system, the "Wratten system," by

1909 when he published The Photography Of Coloured
Objects. In 1912, George Eastman acquired the compa-

ny and Wratten's system became a standard for filters

used in photography, astronomy, and other applica-

tions. Eastman Kodak Company still manufactures

and markets KODAK Wratten Gelatin@ filters. Other

filter manufacturers have their own designations, but

they also often refer to the Wratten equivalent.

There is not a great deal of intuitive logic in the

organizing system for Wratten numbers. Number 25

in the Wratten system is a red filter that passes visible

red as well as infrared wavelengths to the film or sen-

sor (thus blocking wavelengths shorter than 580 nm—

remember that the wavelengths of visible light range

from approximately 380 to 700 nm). You can easily see

through a red #25.

Other filters that block all (or nearly all) visible light,

from 700 nm and below, will be much darker than the

Wratten #25. Depending on their specifications, these

opaque filters are extremely difficult or impossible to

see through.

If you happen to be shooting black-and-white IR with

a red filter, you won't need to compensate for focus

(to use the infrared focusing mark if it exists on your

lens, or hyperfocal distance) because most of the light

hitting the sensor is from the visible spectrum. This

means the focusing distance is the same as it would

be for an unfiltered photograph. All this changes

when an opaque filter is used, because only infrared

light reaches the imaging sensor, and a slight focusing

adjustment needs to be made. If the lens doesn't have

an infrared mark, Eastman Kodak Company recom-

mends that you first focus through a KODAK Wratten

Gelatin @ #25 filter using a small aperture, such as

f/16 or f/22. Then switch to a darker filter because

the depth-of-field at these small f/stops usually off-

sets the slight difference between the visual and

infrared focus. (For more on focusing, see pages 30-35)



Find out if your camera has a black-and-white shooting mode. It can help
you learn what types of scenes work well as monochrome images. 1/2000
second; f/8; ISO 400. Minus 1/3 stop exposure compensation.

As I've mentioned elsewhere, you can sometimes get fooled
about what kind of scene will make a good infrared picture. But
this was a good candidate because of the trees, the grass, and the
way the light was shining at that time of day. 1/1600 second; f/8;
ISO 400.

Cleaning Filters

When cleaning glass screw-mount fil-

ters, you should take as much care as

when you clean your lenses. It's a good

idea to use a microfiber cleaning cloth,

but never chemical lens cleaning fluid,

which might damage the coating. Filters

manufactured with optical plastics

require even more care because they

scratch easier than glass.

Now with the camera set in black-and-white mode, I used a Heliopan
RC 1000, an opaque IR filter that blocks all wavelengths shorter than
880 nm. 10 seconds; f/8; ISO 400. Plus one-stop exposure compensation.



Analyzing Transmission
Rates and Filter Numbers

When trying to describe what an IR filter is actually

doing, we often talk about transmission rates. As

we've learned, a filter is designed to absorb or reflect

certain wavelengths. For IR filters, we are concerned

with blocking near infrared wavelengths and the

shorter visible wavelengths.

If a filter (such as an 89B) has a 0% transmission rate

at 680 nm, it is cutting out all wavelengths below that

number, thus most of the visible spectrum. In general,

filters don't suddenly turn on or off at a given wave-

length, but block wavelengths at a progressive rate of

change. This will vary from filter to filter. Therefore,

the filter with 0% transmission of wavelengths of

680 nm might exhibit a 50% transmission of wave-

lengths of 720 nm, meaning that 50% of the radiation

with a wavelength of 720 nm is transmitted (and 50% is

not transmitted). Typically the rate of change rises quite

sharply, so this particular filter may be transmitting

85-90% or more of radiation with wavelengths

of 750-775 nm.

It would be nice if all filter manufacturers adopted a log-

ical numbering system to identify their filters, but that is

not the case. For example, a Hoya R72 starts to transmit

wavelengths above 720 nm, but the company's RM90

transmits wavelengths above 820 nm. By contrast, the

Wratten 89B, which is similar to a Cokin 007, allows

wavelengths beginning at 680 nm to pass.
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The B&W 092 infrared filter is a dark, purplish red and blocks
most of the visible spectrum, starting to transmit near infrared
wavelengths of approximately 680 nm. Photo courtesy of
Schneider Optics Inc.
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While this lack of a standardized numbering system
can be a source of confusion, it is just the way that fil-
ters and lots of other stuff have been handled in pho-
tography, with each manufacturer creating a number-
ing system as they go (you'll need a Rosetta Stone to
help you decipher it all).

Flare often appears in an image as a series of light circles that
detracts from your subject and reduces sharpness and contrast.
Sometimes you can use flare creatively by pointing your camera
toward the light source.

Flare often takes the form of a streak or pattern of

spots on your image. It can be a problem, particu-

larly when shooting with a wide-angle or zoom

lens, and it's exacerbated when using an IR filter.

One of the most important accessories available

when shooting digital IR images is a proper lens

hood—one that is specifically designed for your

lens. This will help reduce flare that is caused by

strong external light sources.

To make things more challenging, digital cameras

have to deal with more possibility of flare or ghost-

ing than film cameras. Not only can flare and ghost-

ing increase when lenses with flat-surfaced elements

are used on digital cameras, but image sensor and

internal filters are more reflective than film, creating

additional reflections in a digital SLR's mirror box

that result in lens flare. Strong flare can produce a

blurred image that is clearly observable. And even

slight flare reduces contrast, making it difficult to

ascertain if an image is slightly out of focus.

However, there is only one hard and fast rule,

which is: There are no rules. In defense of flare, I

like to use it as a compositional element and some-

ti mes deliberately point my lens so that the sun is in

a corner of the frame, creating strings of reflec-

tions—especially with wide-angle zooms—stretch-

ing across the image. When digital purists see this

they may pull out their hair in a Charlie Brown like

ARRRRGGGGHHHHH! But if you like flare, as I do,

don't let it bother you.
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Filter Choices
Gelatin filters are made by dissolving organic dye in

liquid gelatin, which is allowed to dry. The gelatin is

then cut into square or rectangular shapes. A popular

size is 3 x 3 inches (7.6 x 7.6 cm), although they're

available up to 14 x 18 inches (36 x 46 cm). Since gel

filters are only .1mm thick, they offer excellent optical

quality, but they are fragile. You can tape gel filters to

the front of a lens, but they'll last longer if you use

them in holders designed for the task. Camera manu-

facturers such as Canon, Hasselblad, and Nikon make

gel filter holders as well as accessory manufacturers

such as Cokin, Kenko, and Lee. In the past, gel filters

were inexpensive, but now you can expect to pay $25

or more depending on size and type.

Some glass filters are constructed by sandwiching a

gelatin filter between two sheets of glass. Over time,

these materials could separate, causing bubbling and

peeling. An alternative is to dye the glass in a molten

state, which also means there's no danger of color

shifts as the filter ages. All polarizers are laminated

because they use polarizing film to make the filter do

what it's supposed to do—reduce reflections.

The most commonly used filters are glass mounted in

threaded rings. How well a round filter's mounting

ring is made should be obvious from just picking it

up, twirling it around in your fingers, and screwing it

onto a lens. Premium filter manufacturers such as

Heliopan and B+W often use brass rings because the

material tends not to bind or cross thread. Others use

aluminum because it absorbs shock in the case of acci-

dental impact.

Cokin currently markets four different sized modular

filter systems, all of which include their infrared filter.

These are the A series, the P, the X-PRO, and the

Z-PRO. Each system is designed for the lenses of dif-

ferent formats. Similar modular filter systems are also

available from Lindahl, Pro4 Imaging, Sailwind, and

The three-slot Cokin Z-Pro holder can hold filters of different

thicknesses. Photo courtesy of Omega Satter.
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When I planted this apple tree I didn't realize how convenient it Here a Singh-Ray I-Ray filter was used on the same IR-converted
would be for making IR test shots with new cameras and filters. digital SLR. The exposure is identical to the first example. There is a
This photo was made with an IR-converted digital SLR. 1/15 sec- slight difference in the image: The sky in the Singh-Ray filtered
ond; f/22; ISO 100. i mage is blacker and denser, and the white leaves are whiter.

others. These companies offer their own modular

holder, but the filters themselves are usually compati-

ble with Cokin's holders.

While Lee Filters, a division of Panavision, makes

high-quality glass, resin, and polyester filters predom-

inantly for the motion picture and television industry,

many still photographers use their products. They

offer a few polyester IR filters including an 87 and

87C, along with a Red number 25, in sizes from 75mm

to 100mm square. There aren't any IR movies or TV

shows out there, at least not yet.

Tiffen manufactures both screw-in filters and those

that fit modular holders.

Singh Ray is known for high-quality specialized fil-

ters. They make filters that fit modular holders, such

as Cokin, as well as the ring-mounted I-Ray filter that

blocks nearly all visible light, resulting in some purely

dreamlike images.
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Why is a tripod absolutely necessary if you

plan to shoot IR using a conventional digital

camera with IR filters? Well, there are a couple

of reasons. First, with an unconverted camera,

the IIRC (that hasn't been removed) reduces

the amount of IR wavelengths reaching the

sensor. Second, remember that you need to

stop down in order to take advantage of the

depth of field necessary to insure that IR pho-

tos are acceptably sharp. Smaller f/stops fur-

ther reduce the amount of light that can reach

your sensor. To compensate for these circum-

stances, you will have to increase exposure

ti me, making the use of a tripod or other form

of camera support essential.

A quality tripod is an investment that is sure to

i mprove your photography. It should be sturdy

but lightweight enough so that you'll take it

with you. Otherwise a tripod does you no

good whatsoever. In addition, using a tripod

enforces a deliberate approach to making pho-

tographs. Having to think about composition

before banging off a few frames will improve

the quality of your images more than you

might imagine.

This conventional color photo is used as a reference for the IR images on this
page. The camera was mounted on a tripod. 1/125 second; f/22; ISO 400.

With a Singh-Ray I-Ray filter attached to my lens, I switched to Manual exposure
to set a longer shutter speed at the same aperture. This image was difficult to eval-
uate because of glare on the LCD screen, so I enhanced it in the computer. 6 sec-
onds; f/22; ISO 400.

This image was created using the in-camera sepia mode. Adjusting the
shutter speed from 6 to 4 seconds helped decrease the exposure. 4 sec -
onds; f/22; ISO 400.



Different Filters Give Different Effects

This series of photos illustrates the results of experiment-

ing with different filters. The pictures will give you an

idea of what happens when you place different filters in

front of your lens.

The non-IR color image was shot using a digital SLR. 1/500 sec-
ond; f/9; ISO 400.

Premium IR Filters

Alas, it often seems that there is no middle ground in

IR filters. As soon as you move past the initial con-

sumer-level choices, the price curve rises pretty quick-

ly. This is largely a result of the way these premium

quality filters are manufactured.

Consumer-level filters are generally produced in

much larger quantities and seem to be built to a price

point (so the average photographer like you and me

can afford them), while manufacturers of premium

brands claim higher labor costs because they use

skilled employees and build to tighter tolerances.
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B+W's 090 red filter is equivalent to the number 25 in the Wratten
system. It is also useful for enhancing contrast in digital black
and white and can give great tonal results when shooting land-

scapes. The 090 filter does not create a fully IR photo because it
blocks all wavelengths below 580nm, but allows some visible
light wavelengths to pass. 1/100 second; f/4.0; ISO 400.

These no-compromise filters are not just for fooling

around with IR photography, more often than not

they are used for professional, scientific, and technical

applications, which necessitates stricter standards and

quality control. This includes: high-quality, optically

flat glass or resin that is ground, polished, and coated

to the strictest tolerances of the optical industry and

high consistency from batch to batch. Premium screw-

in filters are mounted in anodized brass rings to

reduce binding or cross threading and to ensure opti-

mal alignment. These high-end filters also tend to be

offered in a wider array of sizes and types, including

bayonet mounts for use with Rollei and Hasselblad.

This extra expense is probably absorbed to a degree

by the pricing of the more popular filter sizes and types.



A B&W 092 IR file created a rela-
tively mild effect in this picture. Why 
is it so subtle? I don't know for sure. 
Sometimes the result
depends on how the filter relates to 
the inherent IR sensitivity of the 
camera's sensor. 3.2 seconds; f/22; 
ISO 400.

The B+W 093 filters out the entire visible spectrum and transmits over 95% of wavelengths longer than 900 nm. Though 
filters like this can create a strong IR photo, hot spots like the one on the right sometimes appear when infrared 
reflectivity is high. These kinds of "blooms" are not always visible on the camera's LCD review screen, which is why it is 
always a good idea to bracket exposure. 10 seconds; f/22; ISO 400.
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Many early Konica Minolta digital cameras are infrared sensitive, so I decided to test how responsive a DiMage point-and-shoot model is to

IR radiation. With the camera mounted on a tripod, I shot this photo using black-and-white mode. 1/1000 second; f/3.3; ISO 100.

Using Filters with

Non-SLR Digital Cameras

What if you don't currently own a digital SLR? Can

you use IR filters with the popular small digital cam-

eras that usually don't have threaded lenses for

accepting filters? Sure, why not?

Some camera manufacturers, including Leica,

Samsung, Sony, and Toshiba, offer adapters to allow

filters to be used on their digital zoom cameras. Plus

there are lots of filter adapters made by accessory

manufacturers. For example, PictureLine makes an

extensive line of adapters for Canon point-and-shoot

digital cameras. Don't overlook one of the greatest

sources of photo gadgets the world has ever known—

Porter's Camera Store. They offer adapters for Canon,

Konica Minolta, Olympus, and Sony digital cameras.

Also, Cokin makes a Digi-Shoe Holder that attaches to

the camera via the tripod socket and accepts their

A-series filters. If you don't have a tripod socket,

don't worry. They also produce the Digi-Magnetic

Holder that works with most small cameras.

However, for best results, the caveat remains that
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Next I held an I-Ray infrared filter in front of the lens. The camera is still on a tripod. The exposure for IR was relatively long. I'll show you
how to add the sepia tone to your black and white IR images in an upcoming chapter. 2 seconds; f/3.3; ISO 160.

there should be as little space as possible between

the filter and the lens. Whatever holder you are

thinking of buying, try it out in your friendly

neighborhood camera store before plunking down

the twenty bucks it costs.
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This is an example of the surreal look that Chip Talbert likes to create. He was struck by the juxtaposition of the
unusual artwork in the foreground with the ordinary buildings in the back. This almost looks like an alien land-
scape. 1/60 second; f/2; ISO 100. Photo © Chip Talbert.

Chip Talbert is a web designer from Chattanooga,

Tennessee whose interest in photography turned

into a passion when digital photography became a

reality. His interest in digital infrared developed

through the practical need to take appealing pic-

tures at midday in bright sunlight—the worst time

of day for visible light photography. Chip quickly

discovered the surreal aspects of digital IR land-

scape and architectural photography and decided

to explore this new application further.

Chip's website (www.chiptalbert.com) showcases his

photography and skills as a web designer. His IR

images are warm-toned, exhibiting classical composi-

tion with technical brilliance. Chip Talbert is clearly a

guy who is passionate about IR photography, and it

shows.
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This image was again shot using a Hoya R72, and was later toned using software. 1/60 second;
f/2; ISO 100. Photo © Chip Talbert.
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meets the eye." Neil Young

Your camera is in hand, ready to shoot. You know

what wavelengths you want to record, and you

understand the focus and exposure challenges posed

by IR photography. Now let's look at creating digital

IR files.

Imaging Sensors

Here's a fact you may not know: The imaging sensor

in your camera records only in black and white. Let

that sink in a minute. Each pixel on a digital camera's

imaging chip contains a light-sensitive photodiode

that converts light to electrical current in proportion

to the quantity of light that falls on it. Photodiodes

can't tell the difference between different wavelengths

of light, they only react to intensity. The typical way

to add color to the digital image is to apply a color fil-

ter mosaic, using a red-green-blue pattern.

There are several ways to do this, but the most com-

mon is a filter arranged in what is called a Bayer pat-

tern, which looks like a mosaic of red, green, and blue

squares. Half of the total number of pixels is filtered

with green (G), while a quarter of the total is filtered

with red (R), and the other quarter with blue (B), in a

repeating 2x2 arrangement. Rows of color in a
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Light is captured by a camera sensor based on its
intensity, not its color. This Bayer pattern is an
example of a color filter array that allows the
camera to interpolate color from this sensor
data. The filter pattern alternates green and blue
in one row and green and red in the next. The
extra green filters allow the processed color file
to better resemble human vision.

sequence of GRGRGR (etc.) alternate with a sequence

of BGBGBG. That's why this output is called sequen-

tial RGB (or sRGB). The camera's processor actually

uses the information from the Bayer pattern to inter-

polate the color of all of the pixels.

Creating
Digital IR Images
"There's more to the picture than



In a Foveon X3 sensor, photodiodes
are embedded in silicon in red, blue,
and green layers. This is similar in
theory to color film emulsion. The
silicon layers absorb different colors
at different depths, thus forming the
full-color image. Image courtesy of
Foveon, Inc.

This is the CMOS (Complementary Metal
Oxide Semiconductor) imaging sensor used
in Canon's EOS Digital Rebel XT. You can't
see the pixels or the RGB filters arranged in
a Bayer pattern, but they're in there. Image
courtesy of Canon USA.
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In its professional level digital SLR, Fuji

uses a Super CCD SR II chip that has

two kinds of photo diodes—shadow (S)

and highlight (R). The larger S diodes

respond to low light, recording shadow

detail, while the R diodes capture high-

lights at lower sensitivity to retain detail.

Fuji claims that this effectively expands

the dynamic range beyond what can be

achieved with conventional CCDs.

In addition to CCD sensors, there are

other types used in digital cameras.

These include CMOS and Foveon sen-

sors, as illustrated here.



Recording the Image
I prefer to create digital IR images using the camera's

built-in black-and-white mode. (We'll shortly consider

what to do if your camera does not have a mode for

recording black and white). When using the black-

and-white mode, you can visually review the black-

and-white image on your camera's LCD screen to see

if the exposure came close to creating the infrared

image you wanted. This is helpful, but even so, the

LCD screen may display different brightness and con-

trast than the actual image, especially with infrared

images. You can tell more about your exposure if your

camera has a histogram function. The bottom line is

this: No matter how close you get to recording your

desired image, there is nearly always room for a few

simple image-processing steps to tweak that less-

than-perfect image in the computer to make it live up

to your infrared expectations.

Tweaking Black-and-White
Images in Image Processing
I believe in using the minimal amount of tweaking

necessary to produce that final image. If you work

with JPEG files, JPEG compression artifacts will occur

every time you reopen them to apply additional

enhancements and then save again. However tiny,

these artifacts contribute to reduced image quality.

They may not matter if you have a large file that you

consider a mere snapshot. But you never know when

you will produce your personal digital equivalent of

Ansel Adam's "Moonrise, Hernandez, New Mexico,"

so it's a good idea to start practicing skillful digital

darkroom habits now, including the habit of saving

your duplicate work-files as TIFFs, which will not

introduce artifacts as you continue to open and re-

save these files.
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Open the original infrared image file (above)

in your image-processing software and make a dupli-

cate for processing (Image > Duplicate). Remember to

save your duplicate as a TIFF file.

Open the Levels option (Image >

Adjustments > Levels) to reveal a histogram of your

image file. The data in the histogram for the photo

above ends well before reaching the right axis, signi-

fying that the image is underexposed, a conclusion

also confirmed by observing the picture. You can

improve the distribution of image tones by adjusting

the histogram.

_ In the Levels dialog box, drag the small white

triangle on the right axis until it reaches the last point

on the graph that shows data. This will add highlight

tones to the image. Similarly, move the small black

triangle from the left axis to the right until it reaches

the point indicating data. This will add rich darks

instead of leaving shadows flat.

The image above now looks more properly exposed, but

it can use additional enhancement. The whites in the

trees still aren't as bright as I would like to see them.



Open the Curves option (Image > Adjustment

> Curves) to make even more subtle and precise adjust-

ments to the tonal range of the image file.

Click the middle

of the Curves diagonal

and drag up to lighten

the image. Conversely,

click and drag down to

darken the image. As a

result of using Curves,

the whites are brighter

(see above). But the over-

all image looks flat to

me—lacking contrast.

Open  the Brightness/Contrast option

(Adjustments > Brightness/Contrast) and add a dash

o' contrast by dragging the Contrast slider to the

right. Because dark areas tend to recede and light

ones seem to come forward, this enhanced the per-

ception of depth in the photo.

I moved the Contrast slider up to 14 for this illustra-

tion, but there are no "magic numbers." Just season to

taste, as Emeril would say. If you click the preview

box (check), you can see the effect of the contrast

adjustment as you apply them to your image.

Compare the original to this adjusted copy

(below). To finalize the image processing, I applied a bit of

selective burning (darkening) and dodging (lightening).

You can try additional experiments; just know when to

quit. I have a "20-minute rule." If the image doesn't look

the way I want within twenty minutes, it never will.



From Digital Color IR to
Digital B&W IR

If you camera doesn't have a black-and-white mode,

you have no choice but to shoot in color and convert

that image into black and white using your computer's

image-processing program.

When you shoot IR in color, your sensor will interpret

the data as a "color" file, even with filters that block or

absorb the color spectrum. So depending on the cam-

era, the filtration, and the IR reflectance of the scene,

the camera will generate an image that usually exhibits

a blue or magenta cast.

Here are some quick and easy ways to turn that

glorious magenta image into something a little

more dramatic.

One of the easiest and simplest methods to create a

black-and-white image from the blue or magenta digi-

tal IR file is to use the monochrome option usually

found in most image-processing programs under the

Mode menu.
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Here is the original color image file that I downloaded from my
converted digial SLR. 1/200 second; f/16; ISO 400.

Make a duplicate TIFF of your blue or magen-

ta IR digital file and select the monochrome or

grayscale option in your image-processing software

(Image > Mode > Grayscale).



Convert the image from color

to black and white by eliminating the

color information. In Adobe

Photoshop, you can do this by chang-

ing the Mode to Grayscale. When you

do so, this dialog box will appear

asking if it's OK to discard the color

information. Click OK and remove

the color.

- Kick up the contrast a bit,

especially if the new monochrome

file looks flat (a condition that indi-

cates a lack of contrast!). The simplest

way to correct this is to use the

Brightness/Contrast control (Image >

Adjustments > Brightness/Contrast).

Gradually move the Contrast slider

(a positive number indicates an

increase in contrast) and observe the

effect until you are satisfied, then

click OK.

The finished image with only two tweaks: The first to remove all
color and the second to increase contrast slightly. That may be all
you need to do, but if you want to try additional methods for
changing from color to black and white, keep reading.
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I shot this image with the Fuji S20 Pro's color mode and a Hoya R72 IR filter. 1/6 second, f/2.8, ISO 400.

Mixing Color Channel
Many image-processing programs offer an option to

produce grayscale images by letting you choose the

percentage contribution from each color channel (R,

G, or B). This control modifies a targeted output, in

this case grayscale, using a mix of the existing image's

color channels. A channel mixing application adds or

subtracts data from a source channel to the output

channel (Gray, when the Monochrome box is

checked). This takes a little more work than the pre-

vious example, but with practice you can whip

through it.
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Channel Mixer dialog window

After opening a duplicate image file, open the
channel mixer option (Image > Adjustments >
Channel Mixer). Be sure to check the Monochrome
box to set Gray as the output channel.



The finished black-and-white IR photograph.

Checking the Monochrome option in the Channel

Mixer dialog box will create an image that contains

only gray values. Move the sliders to control the

amount of detail and contrast in the image you plan

to convert to grayscale. But first make sure the

Preview box is checked so you can view how changes

in each source channel affect the monochrome image.

When adjusting the percentages of the source chan-

nels, you often get the best results when the combined

values of the source channels add up to 100%. If you

go over 100%, you'll overexpose an image. On the

other hand, if you go under 100%, you will underex-

pose an image.

As is often the case in the world of digital IR photog-

raphy, there is more than one way to accomplish your

goals. Mixing channels is a popular method to convert

color IR images to grayscale, but there are others,

including plug-ins. These alternatives, while offering

less control than mixing color channels, take fewer

steps and are faster. That's why I say they are such

powerful tools.
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Open the image file in your image-processing program and create a duplicate TIFF for processing. This original color
i mage was shot with a Fuji S20 Pro camera with a Hoya R72 IR filter. 1/6 second, f/2.9, ISO 400.

Plug-ins: Powerful Black-
and-White Conversion Tools
Add speed to IR conversions by utilizing additional

software programs that make it easier to create

practicular special effects. These programs are known

as plug-ins, and they operate in tandem with your

image-processing program. In the same way that an

electric screwdriver makes household projects faster

than using an old-fashioned hand tool, these powerful

software tools let you produce imaging projects quick-

er and with less fuss than making your way through a

number of menu steps.

There are plug-ins available from many different pro-

ducers that perform all types of effects, and more are

coming out all the time. There is no way we can
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examine all of the pertinent filters available, but

examples of many of the leading products are includ-

ed in the following chapters.

Among the many filters found in plug-ins that work

really well to convert your IR photos to black-and-

white, those in Nik Software's Nik Color Efex product

adapt their effects based on the colors and contrast

range of each image. The complete edition of Color

Efex Pro 2.0 includes three black-and-white conver-

sion filters (the most basic B/W Conversion; B/W

Conversion: Tonal Enhancer with additional contrast

enhancements; and B/W Conversion Dynamic

Contrast). These transform a color image into black



and white while allowing you to manage the high-

lights, shadows, and relationship of the original colors

by using controls for color spectrum, brightness, and

contrast. While all three filters are effective, I like the

B/W Conversion: Dynamic Contrast option because it

contains a Contrast Enhancer that creates an exagger-

ated dynamic range within the image.

For the final image, I only had to move a few sliders in the plug-in's dialog window to produce an excellent IR digital photograph.

As a plug-in, Nik Software's Nik Color Efex Pro 2.0 operates as
part of your image-processing program (in this case, Adobe
Photoshop CS2). The filters in this plug-in are applied to all previ-
ous filter processing changes you have made to the image.
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This original color image was created with a digital SLR that was converted for IR photography. 1/80 second, f/16, ISO 400.

Everybody has their preferred black-and-white con-

version methods, but my current favorite (and maybe

the best monochrome plug-in ever) is Black & White

Studio from Power Retouche. This sophisticated pro-

gram uses the light sensitivity of such films as Kodak

Tri-X and T-MAX to make the conversion, or lets you

create your own sensitivity curves and save them for

later use. This plug-in is compatible with a number of

host applications.
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Power Retouche's Black Definition plug-in is a fine

complement to Black & White Studio. It lets you

adjust black as if it were a color channel. You can also

find filter plug-ins that add Sepia, Van Dyck,

Kallitype, Silver Gelatin, Platinum, Cyanotype, and

other tones to your images.



A duplicate TIFF of the original IR color image file was converted
to black and white using Black & White Studio. A green digital fil-
ter, part of this plug-in, was applied to heighten the IR effect (this
will lighten the "greens" based on the plug-in's preset of generic
"panchromatic" film emulation). Feel free to experiment with dif-
ferent presets and slider values to see what looks best to you—you
can always cancel any effects you don't like.

Like most denizens of the digital darkroom, I'm never satisfied. In this
case, I decided to try to add more snap to the image file. This is an
example of Power Retouche's Black Definition plug-in, which lets you
adjust black and can add extra "pop" to your photo.

Here's the finished IR photograph alter processing through two of Power Retouche's plug-ins for monochrome conversions and enhance-
ment. Could I have toned the final image? Yes, and all of those tips, tricks, and techniques will be covered in a forthcoming chapter.
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"Inlet Reflections." Carl was attracted to this IR scene because the willows along the bank gave off a pronounced white glow from the
warmth of the setting sun. This panorama, stitched from three overlapping frames, was tweaked with Levels and Curve adjustments and
some highlight dodging. Photographed with a Hoya R72 filter; 1 second; f/7.4; ISO 80. Photo © Carl Schofield.
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Carl Schofield worked as a research scientist with the nous green landscape of summer into an ethereal,

Department of Natural Resources from 1960 to 1995 at wintry-white dreamscape where luminous white

Cornell University where much of his work focused clouds appear to float in the darkness of deep space

on the impact of acid rain. His long-term interest in and ghost-like images of trees reflect off inky black

nature and landscape photography dates back to his waters. Capturing images of this unworldly beauty

teen-age years. that surrounds us was a moving, almost spiritual

experience for me."
Carl describes why he developed a passion for

infrared photography: "Beyond red lies the surreal You can see Carl's IR landscapes on his website at

world of near infrared. Invisible to the unaided www.schophoto.com.

human eye, but capable of transforming the monoto-
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"Market Benches" was photographed at the Farmers Market in Ithaca, NY approximately a half hour before sun-
set. The finished print was created by combining four overlapping frames. The exposure was 1/24 second at f/2.6.
A Hoya R72 filter was used to block visible light. Photo © Carl Schofield.



Digital IR
Image Processing

The last chapter demonstrated some of the software

processing that can be used to tweak black-and-white

IR images or convert color IR files to grayscale. Once

you've recorded a digital IR image to your memory

card, you will want to use computer software to com-

plete the process of creating an IR photograph. It is

possible to send the image files from the camera

directly to a photofinisher for prints, but there is so

much more you can do yourself to enhance your IR

images and control the final output. And if you want

to convert non-IR images to look like infrared photos,

image-processing software is a necessity. For a lot of

people, the digital darkroom is a fun part of infrared

photography.

Choosing the right software can be confusing. There

are many different products available, from entry-

level programs that offer only a few image-enhance-

ment options to professional-level packages that are

extremely sophisticated and powerful. These pro-

grams also vary greatly in price, ranging from free

downloads to (relatively) inexpensive packages to

those costing hundreds of dollars.
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"Always, always work with a copy of the original file."
Farace's Laws of the Computing Universe

This old Pontiac hood ornament was photographed using a Nikon digital SLR with a Wratten #87 filter. The far-out colors in this image are a
result of image processing with Adobe Photoshop's Solarize filter. Photo ©Aaron Cathcart.



Scanning: Converting
Your Existing I R Film library

You'll need a scanner if you want to digitize existing

IR film negatives and photographs in your photo

li brary. There are two big myths about making great

scans: The first is that the process is so difficult that

it is beyond the capabilities of the average person.

The second is that it's really easy to make a great

scan. Of the two, the second is truer than the first.

The real secret is to examine all of the scanner soft-

ware's options and make decisions appropriate for

your output.

For many photographers, a flatbed scanner may be

the best solution for converting prints, but if you

have negatives and transparencies, you might inves-

tigate using a film or slide scanner or have them

scanned by a lab.

The typical slide scanner has a slot in the front panel

for inserting a slide or a strip of negatives. When the

scanner starts working, it grabs the slide and pulls it

inside during the scanning process. The features to

look for in a film scanner are similar to those you

want in a flatbed scanner, but you also should know

which film formats it can digitize. If you only shoot

35mm film, you don't need to spend more money for

a larger, more expensive scanner that can handle 4 x

5-inch sheet film.
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Some scanners can scan prints, negatives, or slides.

Before deciding on a specific scanner, you will want

to research the different types to see what will best

meet your particular needs.

When scanning I R fil m or prints, you have the

choice of processing the image after you've down-

loaded the digitized file, or applying certain pro-

cessing before scanning by using third-party acquisi-

tion software such as SilverFast from LaserSoft

International. SilverFast's Prescan feature lets you

freely rotate and resize the image before it's

acquired. Its ScanPilot option automatically guides

you step-by-step through the process of making

individual image corrections. All operations are

done in real time allowing you to see the effect of

any changes you make, and unwanted modifica-

tions can be undone.



This     house was photographed on black-and-white infrared negative film. The negative was scanned and converted to a
positive using Photoshop's Invert command (Image > Adjustments > Invert).

I shot this photo using
Kodak's old E-4 process
with Ektachrome color
infrared film almost 30
years ago, but was able
to use a film scanner to
digitize the image and
bring it into the twen-
ty-first century.



Let's face it, Adobe Photoshop is the 800-pound goril-

la of image-processing programs. Do you need the

"real thing" or one of the other image-processing pro-

grams on the market? Though most of the illustra-

tions in this book were created with Photoshop CS2,

that doesn't mean you can't use some other program.

There are numerous choices, including such packages

as Paint Shop Pro from Corel, PhotoImpact from

Ulead, Photosop Elements from Adobe, and Picasa

from Google. This is far from an exhaustive list, and

sorting out which one is right for you is a matter of

examining the different programs and analyzing

your needs.

How are you going to use the software? It helps to

start with a checklist to define your objectives. Your

long-term goals may be different than your short term

ones. When it comes to software, by the time you've

gained enough experience to thoroughly make use of

all the features in a program, superior new products

may have been introduced. So, focus on your short-

term goals. Do you want to create images for the web

or for sharing family snapshots via email? Do you

want to order framed enlargements to give as gifts?

Or perhaps your interest lies in printing your own

fine art and IR photographs to sell at art shows and

galleries? Maybe you need to provide professional

clients with press-ready images? Determine your

needs and budget constraints, then research the differ-

ent image-processing alternatives to find the best

match for you.

The Layers Function
No matter what program you choose for digital IR

processing, one of the most helpful features is Layers.

That's because pictures in image-processing programs

can be composed of many facets. Think of the paper

used for printing in a conventional darkroom. Layers

are like additional emulsions on the surface of that

paper that allow you to create effects without interfer-

ing with what is on the other coatings. The Layers

option is a powerful tool that lets you add drama and

dimension in images, and can be found in other pro-

fessional processing programs as well as Adobe

Photoshop.

Another way to understand Layers is to imagine an

image that is comprised of stacked sheets of clear

acetate. Any part of the whole image—text or graph-

ics, can be placed on a separate sheet anywhere

within these layers of acetate. In places where there is

no image on a layer, you will see through it to the lay-

ers below. At the bottom of the stack is a background

layer. The advantage of using a program's Layer func-

tion is the ability to adjust or change a portion of the

completed image without affecting the other parts.

This can be as simple as adjusting color or can include

more complex enhancements, such as the addition of

a drop shadow.

The Layers Palette

One of the tools in Adobe Photoshop that helps you

work and navigate within Layers is the Layers Palette.

It features a visible display of all of the layers in an

image, starting from the topmost to the background.

The Layers Palette is used to create, hide, display,

copy, merge, or delete layers from a document.
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You can create new image layers by using the New

Layer button at the bottom of the Layers Palette, or by

choosing the New command from the Layer pull-

down menu (Layer > New). In addition, a new layer

will automatically be created if you drag and paste

selections into your image. You can also copy layers

between two open Photoshop images.

Adjustment Layers

In addition to basic image layers, there are a couple

types of layers that serve different purposes. These are

Fill Layers, which allow you to place colors, gradients,

or patterns within a layer, and Adjustment Layers.

An Adjustment Layer is a powerful option in the

Layer arsenal. It allows you to apply tonal and color

corrections to any or all of the layers underneath it.

These have the same Opacity and Mode options as

Image Layers. By default, Adjustment Layers have

Layer Masks that are indicated by the mask icon

(white rectangle) to the right of the layer thumbnail. A

Layer Mask is like a veil on top of a layer that lets you

hide (or show) and edit selected portions of the layer.

You are able to look at different combinations of these

edits to see how the layers react with one another.

When you achieve the desired result on-screen, you

can merge the adjusted layers.

Photoshop's Adjustment Layers feature lets you per-

form color adjustments without affecting the original

image data, allowing you to experiment with different

adjustments, such as Levels, Curves, Hue/Saturation,

Brightness/Contrast, Color Balance, and other

options. Adjustment Layers can be hidden or dis-

carded at any time, or moved up and down in the

Layers Palette.

This gives you an added dimension of flexibility over

normal Image Layers. Since an Adjustment Layer

affects all layers that are below it in the Layers Palette,

it allows you to make a single adjustment for an effect

on multiple layers. And since an Adjustment Layer is

not making permanent changes to the underlying

image pixels, it can be modified any number of times

without degrading image quality, which permits you

to tweak settings and apply several different varia-

tions of effects that you can swap and/or turn off as

desired. For example, you can create a Levels

Adjustment Layer and use it to temporarily change

the distribution of tones in your image, and then go

back to readjust Levels at any time during processing

by going to the Layers Palette and double-clicking the

icon for the Levels Adjustment Layer. You can do the

same with any of the other kinds of Adjustment

Layers you create for your image file.



This black-and-white infrared picture came right out of my converted Canon EOS digital SLR. It looks pretty nice, but we can have some fun
using Adjustment Layers to change the look of this photo. 1/50 second; f/16; ISO 400.

The New Layer window for creating a Levels Adjustment layer.

Go to Photoshop's Layer pull-down menu

and select New Adjustment Layer. You will then have

a choice between different types of Adjustment

Layers. In this example, a Levels Adjustment Layer is

selected, which opens a window to create and name a

new layer.

Creating Your Own Adjustment Layers

Step 1: As always, open an image and make a dupli-

cate. If you only want to edit a section of the image,

you can select the appropriate portion using any of

Photoshop's selection tools.
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The final IR image

was  created using two

Adjustment Layers. First,

brightness and contrast

were adjusted using a

Levels layer. Then a sepia

tone was applied using a

Photo Filter layer. When

you are sure you are done

processing, flatten the

image if you want to print

(Layer > Flatten Image).

This also decreases the file

size, using less memory.

The Levels dialog window with histogram allows you to adjust
the brightness and contrast of your image.

Click OK in the New Layer window for

Levels and a histogram appears. You can use the slid-

ers under the graph to adjust the intensity of shad-

ows, midtones, and highlights. When you are satis-

fied with your Levels adjustments, apply by clicking

OK again. You can tweak this image as many times as

you wish throughout the processing by double-click-

ing the icon for this Adjustment Layer in the Layers

Palette and moving the sliders to different positions.

The Photo Filter Adjustment layer simulates the use of a filter
placed in front of your lens. Among other things, it adjusts color
balance, white balance, or hue of your picture.

You can quit here or add more layers.

Another type of Adjustment layer is called Photo

Filter. Its dialog window contains a number of fil-

ter effects as well as the option to choose custom

colors from the color picker. Just for fun, let's add

a Sepia tone from the Filters pull-down menu.

The Density slider lets you apply the filter in

exactly the strength you prefer.



Popular IR Image Effects

There are a number of ways to use Layers and other

digital tools to enhance your IR images. Your pro-

gram will contain a number of processing choices,

and you can get additional pieces of software such

as plug-ins and Actions (more about Actions later in

this chapter) to apply many types of practical and

cool effects. (Remember that we took a look at black-

and-white conversion plug-ins in the last chapter,

but those programs have a wide variety of uses in

the digital darkroom and can be used for addition-

al effects, some of which are described in the fol-

lowing sections.)
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Toning
Toning is one way to give your IR images a little color.

In the traditional darkroom, toning is a chemical

process used to modify the color of black-and-white

photographic prints. Different toners produce

different colors in the final traditional print, and you

can even choose to tone some parts of a print

more than others.

You can quickly turn this monochrome IR image into an inter-
esting split tone picture in just a few steps by using a couple
different plug-ins with your image-processing program.

A fun way to use Layers for infrared photographs is

to reproduce a classic darkroom technique in which

different toners are applied to different parts of the

image. This is called split toning. It can be a messy

and tedious procedure in the darkroom, but with

image-processing software, it's a snap. Let me show

you what I mean.



Using PowerRetouche's Toned Photos

Photoshop-compatible plug-in, tone the new layer as

a Cyanotype (which is a blue traditional process). The

Toned Photos filter plug-in offers a number of choices

that mimic the appearance of old photographic

process or toners, including the Cyanotype used here,

as well as Sepia, Silver Gelatin, Platinum, Kallitype,

Palladium, and Silver, among others.

Dpen the original photograph and create a

duplicate file for processing. The duplicate becomes

your Background layer.

Make your first choice about split toning.

This  example shows a Brown Tone layer added to

the Background layer using a plug-in called

PhotoKit from Pixel Genius. Using the Eraser tool,

erase everything on the Brown Tone layer except the

farmhouse and silo. This leaves just the silo and

farmhouse from the Brown Tone layer on top of the

grayscale photograph.

!Select the Background layer in the Layers

Palette and create a duplicate of it (Layer > Duplicate

Layer).

Step 5: Perhaps the blue is too blue for your taste. You

can always lower the Cyanotype layer's opacity using

the Opacity Setting in the upper right corner of the

Layers Palette. This will adjust the effect that the toner

has on the image by letting more of the grayscale image

show through to soften the look.



We're Done! The final image consists of three

layers, including a grayscale background, sepia build-

ings, and a blue tone underlay to create a split tone

image without any muss or fuss. This is a fun and rel-

atively painless way to create sophisticated images

that you may want to print and frame.

If One Tone is Good, Why Not More?

A duotone is a form of printing that uses two colors of

ink, one of which is often black. Duotones were devel-

oped in the printing process as a method of expand-

ing a grayscale image's tonal range, allowing repro-

duction of subtle colors.

In Photoshop, you can use more than 150 preset duo-

tones, tritones (black ink and two other colors), and

quadtones (black ink and three other colors). When

working with an RGB image, you must first convert it

to 8-bit Grayscale (Image > Mode > 8-Bits/Channel;

Image > Mode > Grayscale) before you get to the

Duotone menu. (Image > Mode > Duotone.)

Make a selection in the dialog window from the

Duotone, Tritone, or Quadtone menu, then pick the

specific colors to make up your new image.



I drive by this house every day and hardly ever notice it, but in IR
it's a whole new ball game. Even though it was a cloudy day,
there was enough IR being reflected to create this successful
study. As nice as this photo is, it might look even better as a duo-
tone, so lets give it a try.



Here is the image processed as a Mauve duotone. At this point I usually convert the file back to RGB (Image > Mode
> RGB Color) to save it (the color will not be affected). If you leave as a Grayscale Duotone, fewer of Photoshop's
tools will be available for tweaking later. In this case, I brightened the white a bit using the Levels (Image >
Adjustments > Levels) command.

As a green, black, and white tritone, the picture of the house has a completely different mood that I like. And that's really the point of
applying duotones, tritones, and quadtones to your digital images. Just because an image is monochrome, doesn't mean you can't add
some color to it.



Painterly Effects
Photographers have been applying what many have

dubbed "painterly" effects to their images since the

Pictorialist movement at the turn of the 20th Century.

Digital IR photographers, who are no strangers to this

desire to create artistic effects, often use image-pro-

cessing software to add elements such as a hand-

drawn or a pastel look to their pictures.

To begin, look at the program you are using to see

what types of artistic effects it offers. For example,

built into Adobe Photoshop are many different filters

that let you apply these types of enhancements. When

you select the Artistic menu in the Filter pull-down,

you'll find 15 different effects, such as Colored Pencil,

Neon Glow, and Watercolor. But these aren't the only

choices. Be sure to check out the eight filters for Brush

Strokes (Filter > Brush Strokes) and the 14 effects that

can be found under the Filter > Sketch menu. All of

these selections are collected under Filter > Filter

Gallery, giving you a 37 filters that you can apply to

your images.

These artistic filters usually work best on photos that

have a strong, simple composition. When you choose

any one of these effects, a dialog window appears that

lets you control the degree to which various aspects of

the filter is applied. Don't be timid when making

these judgments; move the sliders to the extreme ends

of their scales and see what happens. A resizable pre-

view window will show a portion of the image. Use

the plus and minus buttons in the lower left-hand cor-

ner of the Filter Gallery interface to zoom in and out

of the scene to see the effects of your slider gymnas-

tics. Don't worry about clicking OK to apply an effect.

If you determine you went overboard, use the Edit >

Fade Filter Gallery command to diminish the effect

until you get something you like better.



Creating Digital Art

Yes, you guessed it! Open a duplicate of

your original image.

Open Photoshop's Filter Gallery (Filter >

Filter Gallery). In this case I opened the Artistic

folder to select the Watercolor filter. While

Watercolor might seem an unlikely choice to use

with a monochrome IR image, its softness counters

the typical hard edges associated with digital

infrared images. This filter gives you control of

brush detail, shadow intensity, and texture using

three slider's.

This tree was shot in Colorado using a Canon EOS digital SLR
converted to IR use. 1/40 second: f/16; ISO 400.

Photoshop's Filter Gallery contains a number of filters within several different folders, including Artistic, Brush Strokes, Distort, Sketch,

Stylize, and Texture. Don't be afraid to try these different effects to see what happens. You can always undo them if you don't like the result.



Do you like the more layered look of this image after the
Watercolor filter has been applied?

Don't be afraid to try other effects and see what you like. I
applied the Dry Brush filter (Artistic folder) to the original,
adding a snowy effect to a photograph that was shot on a
sunny summer day.

For the final image, I took my own advice

and played with the sliders at extreme ends of

their ranges. Ultimately I returned to settings that

were close to Photoshop's defaults.



"Pine Needles, September 2003." This photograph was taken in the Gatineau Hills of Quebec, just across the river from Ottawa. Even
though this was shot on a cloudy day, Rob was able to capture this cool image with a Hoya R72 filter and his Nikon digital SLR. 20 seconds;
f/16; ISO 1600; Exposure compensation of +3.3 stops. Photo © Robert Williams.

Robert Williams is a professional photographer, based

in Ottawa, Canada where he specializes in natural

and urban landscapes. In addition to IR photography,

Rob is interested in making abstractions from his pho-

tographs because he can bend the 'photographic

rules' to try new ideas and techniques. He notes that

digital cameras and computers are great tools for cre-

ating abstract photos because he can attempt so many

of these ideas, keeping what works and discarding

what doesn't without wasting film.

Rob's work is characterized by the use of strong color

and design elements that show his interest of the out-

doors. His photographs have been published in

Nature Canada, Canadian Camera, and MacLean's maga-

zine, and have been used by various nature conserva-

tion organizations.

Rob uses a Nikon digital SLR with a Hoya R72 filter.

He has found digital IR photography a great benefit

in terms of ease and convenience over using IR film.

His website (www.robwilliams.ca) shows a large

number of his photos in several different galleries, as

well as articles and essays about his work. Also

included is a portfolio of digital infrared photographs

along with explanations about how he took each one

of them.





I started with this photo, shot in black-and-white mode using a Leica
Digilux 2 with a Cokin IR filter. 2 seconds; f/2; ISO 400.

Here, I tried solarization, aka The Sabattier Effect. This inter-
face from Nik Software's Nik Color Efex Pro 2.0 Solarization:
Black and White Photoshop plug-in is easy to understand and
use. for this image, all sliders were at the default settings.



Andromeda's Cutline Filter has four built-in
screens and tools for positioning and adjusting
directional screen lines.

Solarization or the
Sabattier Effect
Another of the filters found in Nik Software's Color

Effects Pro 2.0 plug-in is called Solarization: Black and

White. In traditional photography, solarizaton, more

accurately referred to as the Sabattier effect, is one of

the oldest darkroom tricks in the book and works

especially well with strong graphic IR images. It was

first discovered in 1857 when some photographers

noted that exposing a partially developed photo-

graphic plate to light, then continuing development to

completion, would cause a reversal of tones, render-

ing all or part of the negative image as a positive. The

Sabattier effect is not true solarization, which is an

entirely different reversal phenomenon. Classic solar-

ization is the reversal of a portion of an image result-

ing from prolonged exposure to bright light and was

first noted in overexposed daguerreotypes. Man Ray

created some prints using the Sabattier effect, called

them "solarized", and the rest, as they say, is history.

Woodcut Effect
Let me show you an etching! Andromeda Software's

Cutline Filter produces images that resemble engrav-

ings and woodcuts. You can get a number of different

looks from a single original picture.

Color me Escher. I used the default settings in Andromeda Software's
Cutline Filter to create this engraved effect.
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This gorgeous old Buick was shot as an IR RAW file. Once we
give it a little selective coloring, it is going to look even more
beautiful and unusual.

You guessed it! Open a duplicate image

of your original.

Hand Coloring

In Adobe Photoshop you can simulate the popular

hand-coloring techniques of the mid twentieth centu-

ry, only now you can apply the color much more

quickly, and you have a near endless range of color

choices from which to choose. But if you make a mis-

take, you can fix it immediately by using the History

Palette (Window > History) to go back to the point

before you made the mistake. Even after you are fin-

ished with your masterpiece, you can still return to fix

a mistake or change a color by deleting a color layer

and adding a new one.

Make sure to select the option for Color in the Mode pull-down.

Desaturate your image. If your original is a

RAIN tile, like the example of the Buick (left) move

the Saturation slider in your RAW converter to its

minimum setting. If your file is a JPEG, use the pull-

down menu in your image-processing program

(Image > Adjustments > Desaturate). Do not convert

your image to Grayscale; you must leave it as an RGB

or CMYK file.

If you are interested in giving your picture an extra

touch, you could add a slight tone (for example,

sepia) to the image before applying your coloring,

(Image > Adjustments > Photo Filter) or (Layer >

New Adjustment Layer > Photo Filter).

Here's the key to hand-coloring a picture:

Add a Color Layer (Layer > New > Layer), then

select Color from the Mode pull-down in the Color

Layer menu.

Once you add a Color Layer, you will

paint on it instead of on the Background. If you

try to do this same technique with a standard

layer, you will cover all the detail in that area over

which you paint.

Select an airbrush from the Tool Bar. You can use

the bracket keys on your keyboard to make the

brush smaller (left bracket) or larger (right brack-

et). I picked a color by clicking on the

Foreground/Background color squares at the bot-

tom of the tool bqr. This causes a color picker win-

dow to appear.
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From the Layers Palette you
can adjust the color with
the opacity slide at the top
of the palette.

You can fine-tune the chosen color by reducing the
Opacity of the Color layer and by adjusting the Colors in Color
Balance (Image > Adjustments > Color Balance).

You can keep adding
additional layers—one for each
different color. When you decide
you are done, save the file as a
PSD to keep the layers seperate for
future manipulation. But Flatten
(Layer>Flatten Image) the layers
and save a TIFF for printing.

Coloring can definitely add sparkle and a unique flavor to your photographs. Enhance just a selected
portion of your image to focus emphasis on the most important aspects of your composition.
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This IR black and white was photographed with a Canon digital
SLR modified for IR photography. 1/200 second; f/22; ISO 800.

Actions and Artistic Options
Another useful and fun feature of Adobe Photoshop is

called Actions, a collection of short scripts that trigger

a sequence of image-processing steps that can be

applied to IR or non-IR photo files. With a single click

you can use Actions to deliver a variety of different

coloring and artistic effects.

I applied Blue Steel Action found in the Fashionizer set from Craig's
Actions to add color to my IR photo. Like most Actions, Blue Steel is a
one-click application. Press the button and watch it happen.

The Actions Palette lets users record a sequence of

editing steps as an "Action" that can be saved, then

utilized again at a future time. An Action can be

applied to a selection in an image, another image file,

or—in a batch operation—to hundreds of different

image files. You can create and save your own

Actions, get them from friends, or download them

from the Internet. Some are provided by Adobe on

their Photoshop CD-ROM in the "Goodies" folder.



I used an oil painting Action to get a soft yellow look, then a snowy Action to turn the summer into winter. Both of
these Actions are free to download from the Adobe Studio Exchange website, which has over 10,000 files for you to
explore.

Actions are not applications, plug-ins, or even filters;

they are simply a series of instructions that direct

Photoshop to produce a desired effect. They are easy to

use and can be customize based on how you apply them.

The Actions Palette is your key to creating and using

Actions. To open it, go to Window > Actions once your

image is open in Photoshop. The Palette drops down

showing a list of available Actions. To apply, highlight

an Action from the list and click the triangle icon (Play

selection) at the bottom of the Palette. Voila!

It can be useful to share Actions with other photogra-

phers. The sharing process is made easier by the fact

that Actions are completely cross-platform. If you cre-

ate an Action in your Mac OS, anyone using the

Windows version of Photoshop can load and apply

your original Action to their images. In either Mac

OS or Windows, Actions typically use an ".ATN"

file extension.



Creative Edges

One of the hottest trends in digital images is a photo-

graph with irregular, ragged, or artistic edges. Even

National Geographic has used soft-edged photo-

graphs to illustrate a story or two. With image-pro-

cessing software, it's not difficult to produce these

kinds of effects.

Here are some reasons you might want to try adding

creative edges to your own photographs:

• Photographs with irregular edges add variety to

your portfolio by providing visual relief from straight-

edged vertical and horizontal rectangular shapes.

• The edges of images with white backgrounds or

light colored corners tend to disappear from the final

print. A creative frame adds a decorative border to the

photograph, giving the finished image a more clearly

perceived edge.

• Instead of cropping to clean-up distracting ele-

ments, you can use creative edges to hide minor com-

positional flaws while adding a touch of panache at

the same time.

• Creative edges can add an artistic touch to an image

that might otherwise appear too literal.

• Playing with creative-edge effects is fun.

onOne Software PhotoFrame

This Photoshop-compatible plug-in provides a huge

assortment of frame and border effects. The program

lets you enhance your images by adding a variety of

special effects to their edges, including drop shadows,

inner and outer glows, bevels, textures, blur, noise,

opacity, and blends that can allow you to customize

and save these special edge effects you've created. It is

available for Mac OS and Windows and you can down-

load a demo copy that includes several frame samples.

Let's look at onOne Software PhotoFrame to see how to create
edges and frames to enhance your IR photos. This picture
was shot with a digital SLR converted for IR photography.
1/200 second; f/22; ISO 800.
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The interface for PhotoFrame includes a large, resizable real-time
preview window along with dockable palettes that let you maxi-
mize monitor space. The editing environment includes multiple
Undo/Redo, a pop-up navigator, eyedropper color extractor,
background processing, zoom, pop-up tool tips, and vertical
pop-up sliders.

PhotoFrame not only works with the 1000 frame files found on
the program's CD-ROM, but you can also build your own custom
frames and edges from scratch or by adapting existing frames.

You can even use onOne Software PhotoFrame to add a little color to
your monochrome image. This frame is one of five frames that simu-
late transparent or translucent tape so it looks as though your photo
is taped to a background surface.
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Photo/Graphic Edges
Auto F/X is the company that first made creative-

edge effects popular with digital photographers.

Initially, they supplied CDs with files for graphic

edges that you applied to your images using Adobe

Photoshop's tools and commands. While the process

was not difficult, some users found it too complicated,

so Auto F/X quickly developed a plug-in that made

the job much easier.

Photo/Graphic Edges can add torn, ripped, deckled,

feathered, painted, film frames, and darkroom-styled

edges to any grayscale or color image. The latest

package contains four visual-effect modules: Edges,

Montage, Vignette, and Frames; each module gives

you complete control over the edges of your pictures

and also lets you apply surface grain, lighting, shad-

ing, matte, or colored backgrounds. The latest version

features such effects as Traditional, Darkroom,

Painted, Etched Scratchboard, Darkroom Transfers,

and much more. Included in the package are more

than 10,000 edges as well as hundreds of color frames

and texture effects.

Using any of these software tools can be fun. Just

open an image and experiment with all of the pro-

gram's features. Don't worry about making mistakes;

there are no mistakes when producing edge effects,

just use common sense and good taste. After a while,

you'll feel like you want to add edge effects to all of

your images, but don't do it. A true maestro of tradi-

tional darkroom techniques, the late Edward L.

Bafford, warned me that you should have somebody

standing nearby with a wooden two-by-four to

"knock you upside the head" if you got too carried

away with any one particular technique. Use creative

edge techniques sparingly and only with images that

will be enhanced by the effect, otherwise they will

loose their special quality

Photo/Graphic Edges includes 1000 matte textures and 200 light-
ing tiles to give you a custom look and a seemingly infinite com-
bination of effects. This program is delivered as both a plug-in
and as a standalone application for Mac OS or Windows.
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By playing with some of the possibilities in Photo/Graphic
Edges, I created this montage-style frame.

Digital Noise
Finally, noise is an additional factor to keep in mind

as you attempt to optimize the quality of your digital

IR photos. Not only do all digital cameras add sensor

noise to images, but noise is also caused by image

processing and file compression. Like film grain, sen-

sor noise is more noticeable at high ISOs in areas of

uniform color, such as skies and shadows. There are

many software packages that help reduce the appear-

ance of digital noise. Following is a short list of prod-

ucts from the many I have tested, in order of my per-

sonal preference. Keep in mind that your camera and

the kind of images you make may be different than

mine, so download a free demo version of each prod-

uct and try it yourself.
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• Noise Reduction Pro

This is the first tool I reach for to reduce high ISO

noise, sensor color noise, JPEG artifacts, and color

fringing. Unlike the less expensive non-Pro version, it

features separate controls for luminance (brightness)

and color noise. It is not the strongest grain removal

product available, but its application avoids the

mushy look that some noise reduction solutions pro-

duce. Download the 30-day demo versions of both

Pro and non-Pro versions of the plug-ins and try each.

• Grain Surgery

Grain Surgery reduces digital noise, film grain from

scanned images, JPEG compression artifacts, and will

even remove halftone patterns from scans. The inter-

face provides easy access to all settings, a wonderfully

useful split-screen comparison window, and allows

you to save your settings and reload them later for

similar image files. It even lets you add grain from

built-in samples of your favorite grainy film.

• Digital GEM Professional

Eastman Kodak's Austin Development Center offers

this plug-in that also supports 16-bit images. The

Clarity control in its dialog window lets you cus-

tomize the effects by providing additional sharpening

or softening to the overall image, while a Radius slid-

er controls the pixels surrounding the area affected by

the sharpening/softening. A Noise Preview Screen

shows the actual image noise/grain that's affected by

your setting choices.
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• Noise Ninja

Noise Ninja is available either as a standalone appli-

cation or a plug-in for Photoshop, which is the way I

like to use it. It uses a proprietary type of wavelet

analysis that doesn't introduce artifacts, such as ring-

ing or blurring edges. To refine its noise-reduction

capabilities, it applies camera profiles that are offerec

free on its website.

• Noiseware

This program removes high and low ISO noise, JPEG

compression artifacts, and moire patterns, and is

available as a Photoshop-compatible plug-in or stand-

alone application. It contains a 'self-learning' algo-

rithm to collect data about your camera or scanner

that allows it to continuously improve the processing

every time you run an image through it: The more

you use Noiseware. the better the results.



Eric Cheng was one of the pioneers of near infrared

digital photography with consumer cameras. He has

been taking digital infrared photographs since 1998,

and has written extensively about the technique in a

number of publications, including PEI magazine,

Digital Photo FX magazine, DigitalFOTO magazine. He

has also contributed to the books The Future of
Memories and The Advanced Digital Photographer's
Workbook.

Though the camera that took the pictures above had

the hot mirror removed, Eric points out that shooting

infrared with digital cameras can be as easy as attach-

ing a visible-light blocking filter to the front of the

lens. A good first filter to try is the Wratten #89B. He

says, "You should be able to capture images in

infrared after you securely attach the filter to the front

of your camera and shoot with flash turned off. Using

a tripod is essential, because your camera will almost

certainly be shooting at low shutter speeds!"



Eric used the same camera for this image with an exposure of 1/119the of a second at f/4.9 with an ISO 100. Adobe Photoshop
was used to convert the image to black & white and selectively soft-focus (Gaussian blur, sharpening, and masking) the skin
areas to simulate the haloing of infrared film. Photo © Eric Cheng.

Eric is also a professional underwater photographer,

and is the editor of Wetpixel.com, an award-winning

website and online community dedicated to digital

underwater photography. More about Eric can be

leaned from his personal website: http://echeng.com
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Creating
Infrared Effects

"My true program is summed up in one word: life.
I expect to photograph anything suggested by that
word which appeals to me." Edward Weston
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Powerful Plug-ins for
Conversion to IR

You've read about shooting IR images with either an

IR-converted camera or a conventional digital camera

using IR filters, and how to enhance those pictures

using image-processing software. But what if your

digital camera does not have very good IR capability?

Or what about that large library of non-IR digital

shots you already have? Some would make great

infrared images with a bit of digital darkroom magic,

wouldn't they? Don't worry; you can use digital tech-

nology to create the infrared look with non-IR photos.

We've already examined a number of different uses

for plug-ins. Just as they were compared to power

tools when converting digital color IR images to black

and white, they are also available to create faux IR

images from conventional photos.

For example, an assortment of filters in the Exposure

plug-in from Alien Skin Software allows you to recre-

ate the specific look of particular film stock. This

plug-in allows you to replicate the look of such IR

films as Ilford 200SFX, Kodak HIE, and Konica 750.

The Pebble Beach golf course was photographed in visible light using a conventional digital photo point-and-shoot camera. This
i mage is comprised of five separate photos, which were stitched together using the PhotoMerge feature in Adobe Photoshop.
Finally, a transformation to faux infrared was created with Nik Software's Nik Color Efex Pro 2.0.
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While this photo of a gazebo and lake was rather
unspectacular, I thought it could be transformed
in the computer. 1/200 second; f/11; ISO 200.

There are two infrared conversion filters in Nik

Software's Nik Color Efex Pro 2.0 package that are

also designed to imitate the look of photos shot on

infrared films: Infrared: Black and White and Infrared:

Color. The Infrared: Black and White filter can be used

to create stunning landscapes, with dark skies, bright

white clouds, and glowing white vegetation. This fil-

ter also produces excellent results on a wide variety of

other subjects, from portraits to travel photographs.

The Infrared: Color filter produces images with inter-

esting color shifts.
You can't see them all in this illustration, but there are four
choices for effects in the pop-up menu for Nik Software's
Infrared: Black and White filter. This one created the effect
I liked best. Try them all before clicking OK.

The monochrome rendition and the shimmering white in the
grass and tree help simplify and strengthen this composition.
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A color digital photo made at the Colorado Railroad
Museum.1/125 second; f/8; ISO 80.

No foliage? No problem. That's
the time to create some faux-
color digital infrared. Again,
this is an example of an image
created with Nik Software's
Infrared: Color.



I used the default setting to

produce this result. Now I
know what those leaves and
sky look like in IR.

Another simple alternative is to take a conventional

digital color image and convert it to look like infrared

using a different plug-in, Silver Oxide's Silver IR filter.

Based on the photo's spectral signature, an indication of

the IR reflectance contained in different components of

the scene, Silver IR uses a proprietary algorithm to sep-

arate parts of the image and create an IR simulation.

This digital image was shot with a Fuji Finepix
3800 digital zoom camera. What would those
leaves and sky look like in IR? 1/100 second;
f/8; ISO 100.

The interface to Silver Oxide's SilverIR filter may look complicat-
ed at first, but it is not difficult to figure out. This filter will create
an "infrared image" from a standard color digital file.
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This 1931 Ford Model A station wagon is not your typical subject for
infrared photography, but I wonder what it might look like in IR. Don't let
anybody kid you; there are no specific subjects you should or should not
photograph in infrared. Let your interests be your guide. 1/500 second;
f/3.5; ISO 125.

True-Pro-Converter from AboutDigicam is a single

Photoshop-compatible plug-in that provides a num-

ber of digital conversions, turning color files to black

and white, sepia, and infrared. It also lets you emulate

Fuji's Velvia film, normal or saturated, as well as color

infrared. The upside of this clever product is that it is

relatively inexpensive. The downside is that it is only

available for Microsoft Windows. Sorry, Macheads.

One of the joys of using a versatile plug-in is simply
clicking a button to preview a number of possible
effects. AboutDigicam's True-Pro-Converter will easily
convert a digital image to enhanced color, mono-
chrome, IR color, or IR black and white. When I saw
how cool the Woody looked as an IR shot, I knew it
had to appear in this book.

A psychedelic woody
sounds like something
Janis Joplin might have
sung about in the sixties,
but here it is today as a
faux color infrared thanks
to True-Pro-Converter's set
for conversion to color
infrared. The picture is
pretty enough to frame, so
I added a digital frame
with AboutDigicam's free
Photoshop Action.
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Not So Pseudo-Infrared Color

This photo looks like it may be a faux

infrared image, but don't be fooled. By

now we know that color IR i mage files

shot with a filtered or converted camera

produce magenta images that have to be

converted to black and white to get the

look you want—or do they? That may well

be true when shooting in a highly intense

IR-filled environment, but what happens

when that isn't the case?

This photo is one result, and I like the soft-

er look. It was shot in the soft light of my

north-facing kitchen with a Canon EOS

digital SLR converted for IR. It may not be

crisp, but the colors you see are exactly as

the file was recorded on the memory card.

Model Tia Stoneman's auburn hair translat-

ed in-camera into a very cool blue.

( Handheld; 1/13 second; f/16; ISO 400.)

If there is any message here, it's that you

should always experiment! Don't take what

anybody, including me, says as the

absolute truth unless you try it yourself.

There are too many variables in digital IR

photography for it to be "my way or the

highway."



Using Actions
Remember Actions from the last chapter? Well,

they can also be applied to non-IR images. Go to the

Windows pull-down and click Actions to see the

Actions Palette. A list view of available Actions

will appear.

You can create and edit Actions by using the New

Action command, found in the pull-down selections

by clicking the right-facing triangle in the upper right

corner of the Palette, or at the bottom of the Palette by

clicking the page icon with the corner turned up

(Create new action).

You can take a different view of the Actions Palette by

checking Button Mode in the pull-down activated by

the upper right triangle. When Button Mode is select-

ed, you will see a check mark next to it and you can

now click a button to play back any actions you may

have created.

While in either Button Mode or List view, new

Actions can be added to the palette by selecting Load

Actions from the pull-down menu. This command

brings up the standard Open dialog window, allowing

you to select and load your new .ATN file. When a

new Action file is added to the palette, it is placed at

the bottom of the scrolling list. If you want to move

an Action, switch into List view and click and drag it

to wherever you want.

Although Actions can be used to apply creative

effects, they are not filters and don't have to be treat-

ed like filters. Some pundits recommend that you

store them in a folder or directory and load them as

you need them. I don't think that's a good idea. One

of the main attractions of Actions is that they are a

convenient way to accomplish tasks. Since the Actions

Palette is scrollable, I think you should keep all of

your favorite Actions stored there ready for use. The

trick is not to blindly accumulate Actions, but to

explore and test to find ones that fit the way you

work. If you uncover a marginal Action, store it in an

"Inactive Actions" folder (or send to the trashcan, if

you wish).

Since most Actions take less than 10K, you don't have

to be worried about download time (or hard disk

space). There are not as many Action websites as there

are those dedicated to plug-ins, but a few sites com-

bine Actions and plug-ins. One source for pre-record-

ed Actions on the internet is Adobe Studio Exchange.

This well-produced site has a section that lists all of

its Actions available for free download, showing a

sample image of what the effect looks like.
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This scenic image was originally shot on Kodak Ektachrome film with a Nikon FM2 camera. It was digitized using a film scanner.

The B&W Infrared Action that is part of the Film & Grain Fx Simulator Action set by das bosun is found on Adobe's Studio Exchange
website. It imitates the look of Kodak's High Speed Infrared ( HIE) black-and-white negative film exposed with a red filter.
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Film & Grain Fx Simulator
by das bosun

This is a set of Photoshop Actions, found in Adobe's

Studio Exchange Resource Center, that emulates film

and printing techniques. It simulates contemporary as

well as historic film processing and printing tech-

niques, including cross processing, infrared (color and

black and white), cyanotypes, litho prints, and many

more. These actions are not recommended for images

embedded with ProPhoto RGB color space or other

similar wide gamut color spaces, but they work great

with sRGB & Adobe 1998 files.

Black and White Infrared Film
by Rozilynn

This is another Action from Adobe's Studio Exchange

Resource Center that imitates the look of black-and-

white infrared film. It works best on images contain-

ing foliage, but the author suggests that you "try it on

anything; you never know what you'll get. It's not the

same as regular black and white, it's a lot contrastier,

and has a dreamy effect."
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Craig ' s Actions

This is a suite of commercially available Actions that

includes InfraRedders, found in Craig's Storytellers

One product. With Actions for a number of IR effects,

including custom effects for portraits and

"ExtraStrong," you always have control over the look

you want to achieve and the ability to modify it at any

time. Craig's Actions offers sets for black-and-white as

well as color IR.

Craig offers an excellent set of actions for black-and-white
infrared (above) plus the best color IR Action I have ever
tried (as demonstrated to the right).
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Cross Processing
Back in the old days of film, one very neat way to get

special effects was to use a technique called cross pro-

cessing. This could produce a result that was often

similar to color infrared film photography. It was easy

to do, required no filters or special handling, and

looked cool.

Processing negative film in transparency chemistry is

called C-41 to E-6 cross processing, while processing

transparency film in negative chemistry is called E-6

to C-41. The C-41 to E-6 cross process causes high-

lights to shift to a warm, peach color, while the shad-

ows take on a blue cast. The E-6 to C-41 cross process

creates a contrasty image, with blue highlights and

detail fringes.

Cross processing can be emulated in digital photogra-

phy using image-processing software. One method for

digital cross processing that creates really good results

has been developed by Danny Ngan. His technique

aims to produce a dramatic film-based look while keep-

ing the process as simple as possible.

In Adobe Photoshop, use Adjustment Layers so it is

easier to adjust the settings to get an effect that you

like. This control also allows you to apply different

variations and the ability to judge their effect by turn-

ing them on and off.

This is an example of the faux-color IR effect you can achieve with true chemical cross processing. The house was shot on color negative film
but developed with E-6 chemicals for color slide film. It's not always easy these days to find a photo lab that can do this for you.
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This conventional color photograph was shot with a Canon EOS digital camera. Use it as a basis for comparing the faux or pseudo IR
effects demonstrated in this chapter. 1/180 second; f/9.5; ISO 100.

The dialog window for creating a Curves Adjustment Layer. Click
OK to see the Curves dialog window appear.

Step 1 With a copy of the source image open, start by

creating a Curves Adjustment Layer. This can be done

from the menu bar (Layer > New Adjustment Layer >

Curves), or you can use the Create Adjustment Layer

button at the bottom of the Layers Palette (it's a black

and white circle icon.) Name the new Curves

Adjustment Layer if you wish and click OK.

complete guide to digital infrared photography 123



Step 3: Adjust the individual (Red, Green, and Blue) color

channels in the Curves dialog window by selecting your

desired channel in the pull-down menu at the top of the box.

For the Red channel, increase the contrast, making the shad-

ows darker while keeping some red visible in the picture.

Step 2: When the Curves

dialog window opens, choose

RGB from Channel options at

the top of the box. Then click

on the grid to create a point

that can then be used to

adjust Curves. A curve shape

similar to the illustration

above works well, reducing

the darker tones and increas-

ing the lighter tones to pro-

duce more dramatic lighting.

But don't be afraid to experi-

ment. With the Preview box

checked, you can adjust the

shape of the graph while

watching the effect on the

image. You can always click

the Cancel button and try

again if you don't like the

way your adjustments look
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Step 4: For the Green channel, keep most of the

dark tones where they are, but brighten the mid-

tones and reduce the lighter tones to add a more

green-yellowish tint to the image.

Step 5: Adjust the Blue channel, then apply the changes

for the Curves Adjustment Layer by clicking OK. If you

like the results, you can save settings made for all the

color channels in the Curves dialog window for use on

another image.

Step 6: Add a Hue/Saturation Adjustment Layer.

The resulting dialog window contains slider controls

and a pull-down menu for making adjustments. These

options let you adjust not only the hue and saturation,

but also the brightness of either the complete master

or a specific color component of an image. Play with

the Saturation slider to add some punch. Bam!
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Cross Processed? Maybe not in the "official" sense, but this method definitely produces a color infrared effect. How does this
stick-shift method of moving step-by-step compare to using an automatic power tool? You'll soon find out.

Do Your Curves Look Like Mine?

For your particular photographs, the curves in the dia-

log windows may look different than my examples,

depending on the source image's colors. But the pri-

mary goals in this faux cross-processing method are to

increase contrast, create dynamic colors, and add a

slight tint to the overall image. This was a relatively

high key (lighter tones) image. You can see Dan

Ngan's process using a low-key (darker tones) image

file at his blog site listed in the back of this book. The

bottom line: Experiment with different combinations

of adjustments to get a look that's pleasing to you.
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The E-6 to C-41 cross-processing plug-in from
Nik Software may produce an image that is
less refined than Danny Ngan's technique,
for instance lacking a bit of glow and yellow
tone. But the plug-in is fast. The loss of sub-
tlety is the price you pay for speed.

This is cross processing in the opposite
direction, using Nik Software's Cross
Processing: C-41 to E-6. Clearly this process
yields its own type of look.

Cross-Processing Plug-ins
The preceeding method is fine for those who want

precise control over each step of the cross-processing

procedure. But there are plug-ins for this technique

that give you results much more quickly.

One package that is very effective is Nik Color Efex

Pro 2 from Nik Software. This set of Photoshop-com-

patible plug-ins offers both E-6 to C-41 and C-41 to E6

cross processing effects.
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"Watermane" was one of
Reggie's first successful
white balance experi-
ments. In addition to the
color, note the reflection
at the top of the falls com-
pared to the swirling water
below. This one was also
photographed using a
Hoya infrared R72 filter.
The exposure was
13 seconds at f/5; no ISO
was recorded. Photo ©
Reggie Linsao.

Reggie Linsao started his career as a nature pho-

tographer. He has found digital infrared IR "to

be the perfect complement in the digital age."

He continually asks himself how a subject would

look if shot in IR, and that's a question you

should continually ask yourself, as well.

While Reggie appreciates the black skies and

white trees found in black-and-white IR, as a

nature photographer he loves color. These exam-

ples of his work show how he incorporates color

into his IR photographs.

When he began shooting IR, Reggie experiment-

ed with the white balance settings in his camera,

then graduated to creating a custom white balance he

uses for his IR photography: "I was all set up with my

Canon Poweshot G3 and took the photo of the water-

fall below with the IR filter on, and used that photo as

my custom white balance setting. I metered off of the

bands of water in that picture, which interestingly

enough were actually a yellowish-brownish color to

begin with. My custom white balance will give con-

sistent results, but I've also discovered that the angle

of the sun to your subject can influence the intensity

of the colors."

Visit Reggie's website to find IR photographs and arti-

cles about his observations and techniques:

www.boomslice.com
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"Triad" captures the detail of the bare branches against a warm sky. Reggie does not recommend shooting into
the sun, but in this case it adds drama. He used a tripod-mounted Canon PowerShot advanced compact zoom
digital camera with a Hoya infrared R72 filter. 5 seconds; f/3.2. No ISO was recorded. Photo © Reggie Linsao.
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Printing IR Images
with Ink Jet Printers
"...the picture-taking process...is an intuitive thing. You can't
go out and logically plan a picture, but when you come back,
reason then takes over and verifies or rejects whatever you've
done. So that's why I say that reason and intuition are not in
conflict—they strengthen each other." Wynn Bullock.

Ansel Adams, who was also a pianist, often compared

photography to music. He felt the act of shooting a

photograph was akin to the production of the musical

score, but the finished print was its performance.

Nowadays it is more than likely that a print will be

digital than silver-based.

Printing photographic images in your desktop "dark-

room" means no more working in the dark with fin-

gers soaking in smelly, maybe dangerous, chemicals

while waiting for results to appear on dripping wet

paper. This is not to demean traditional darkroom

methods; there is nothing more luminescent than a

platinum or palladium contact print made from a

properly exposed large-format negative. Printing

using digital technology is simply the latest link in a

chain that started when Louis Jacques Mande

Daguerre placed a silver coated copper plate in mer-

cury vapors and watched an image appear.

Some photographic purists may scoff at digital print-

ing, claiming that images created using computer

technology are not permanent, but the truth is that

while some traditional photographic prints may be

processed to assure permanence, many are not. In

comparison, some digital prints are produced using

inks and papers that will create an archival print,

130 printing IR images with ink jet printers

while others are not. The choices made when printing,

whether through experience or inexperience, deter-

mine the final result.

Inks and Papers
We all know how today's photorealistic ink

jet printers and papers work together, don't

we? All you have to do is stick some paper

in the printer, tell your image-processing

program to print photo-quality output, and

the results are always perfect. Right?

Printing is simple if you use Canon paper

with a Canon printer, or Epson media in an

Epson printer. The driver software from

such printers is matched to their own brand

of paper, so there are few surprises when

you see the output.

But what happens if you use different

media with your brand-name printer? The

printed results may not look great. So

here's a little primer on printers.



All ink jet printers spray ink through nozzles, or jets,

onto paper. The technology used to print images falls

into two general categories:

• Micro Piezo: Much like a tiny Super Soaker, the

micro piezo print head, used primarily in Epson

printers, squirts ink through nozzles using mechanical

pressure. Depending on the amount of current

applied, the print head changes shape to regulate the

amount of ink released.

The amount of ink that exits the print head is meas-

ured by its droplet size. In general, the smaller the

size, the better the image quality. Ink droplets are

measured in picoliters, which are one million mil-

lionth of a liter! Printer resolution is rated in dots per

inch, or dpi. A 720 dpi device prints 518,400 dots of

ink in one square inch (720 x 720). The greater the

number of dots, the higher the printing resolution. Be

careful not to confuse these specifications with image

resolution—they are two different things!

• Thermal: In this system used by Canon, Hewlett-

Packard, Lexmark, and others, ink in the print head is

heated to its boiling point so it expands before it is

forced through the print head's nozzles and onto the

paper. There are variations in how each company

accomplishes this, but you get the idea.

Photo © Carl Schofield
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Printing Your Photos

One of the first things digital photographers usually

want to do after shooting an image is to print it.

Printing is one area where technical advances have

freed us from most of the restrictions of the traditional

darkroom. For most photographers the intended use

of prints is along the classic line of the three "P's"—

proofs, prints, and portfolios.

Portfolios
One advantage of making digital prints for this type

of use is the ability to update and customize each

portfolio that you send out. Having a good ink jet

printer lets photographers print high-quality portfolio

images up to 13 x 19 inches (33 x 48 cm).

Proofing
Digital color printing got its start as a proofing device

for making a quick approval print for a client before

producing separations. Many photographers still use

their desktop printers for this purpose. A paper proof

printed on relatively inexpensive but high quality dig-

ital media provides insurance that the final 4-color

process print will look the way it is supposed to look.

Making a paper proof is also a good idea when send-

ing a digital file to a client or service bureau so the

recipient knows what the finished image should look

like. I made proof sheets of all of the images for this

book to give the separator an idea of how the picture

should look when printed.

Printing
The papers and inks used by the latest ink jet printers

generally produce prints that last as long as a lab-

made print. For most applications, the people receiv-

ing the prints don't even ask if they're "digital"

because they look just like "real" photographs.

Managing Accurate Color

The revolution in color ink jet technology forever

changed the nature of desktop printing. For less than

$100, inexpensive printers from companies such as

Canon, Epson, HP, and Lexmark, let you produce

photographic-quality output, but there is a price to be

paid for this capability: Excellence becomes the

accepted standard. As color printers have become bet-

ter and better (and cheaper too), end users have

begun to demand more from them: Not just higher

resolution, but more accurate color. This quest has

engendered an endless cycle of printer improvements,

all developed to achieve color nirvana.

Before arriving at the destination of accurate color,

there are many roadblocks that must be overcome,

including price. Somewhere along the way, you are

going to have to stop and ask yourself this question:

"How much am I willing to pay for accurate color?"

Your answer determines which of the many soft-

ware and hardware solutions are appropriate for

your situation.
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The color temperature of Ott-Lite's
VisionSaver Plus table lamp is
5100-5300 K. It is designed to simu-
late natural daylight indoors. Photo
courtesy of Ott-Lite Technology.

Lord Kelvin and the Temperature of Light

In the nineteenth century, Lord Kelvin, an Englishman,
proposed a temperature scale suitable for measuring low
temperatures. He suggested that an absolute zero tempera-
ture should be the basis for his scale. Lord Kelvin's idea
was to eliminate the use of negative values when measur-
ing low temperatures with either the Fahrenheit or Celsius
scales. In honor of his contributions, this system is called
the Kelvin scale and uses the unit "Kelvin" (sometimes
written as K). The color temperature emitted by light
sources is measured on this scale. The sun on a clear day
at noon measures 5500 Kelvin. On an overcast day, the
color temperature of light rises to 6700 K, while 9000 K is
often what you'll experience in open shade on a clear day.
These higher color temperatures are at the cool, or blue,
end of the spectrum. Light sources with lower Kelvin tem-
peratures are on the warmer end of the spectrum. Lights
used by videographers or photoflood lights usually have a
Kelvin temperature of 3200. Household light bulbs meas-
ure about 2600 K. A sunrise may be well down on the
Kelvin scale—at about 1800 K. So what's my point? Well,
in this case, just that you should consider the color tem-
perature of the light source when viewing prints.

There are a few obstacles standing in the way of
obtaining an exact color match between what you see
on the monitor and what your printer will deliver.
The most fundamental difference involves the fact
that a computer terminal displays an image by trans-
mitted light. This is similar to viewing a slide on a
light box: Light is coming from behind the image.
When looking at a print, you are seeing it by reflected
light. And this difference can be exacerbated by envi-

ronmental factors, including monitor glare and the
color of the light source you are using when viewing
the print. While light may appear white to our eyes, it
actually comes in many hues.
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Monitor Calibration

If you go into any professional photographic lab or a

commercial printer, you'll find a special area set aside

for viewing output. This area will have test prints

posted and will have lighting fully corrected for day-

light. If it looks good in the viewing area, it'll look

good anywhere. Most computer users can't afford the

kind of viewing boxes professional labs have, but Ott-

Lite sells affordable accessory lamps that can bring

color-correct viewing to your desktop printer. They

offer a family of modestly priced VisonSaver lights

that you can place near your printer to help you see

color properly. Ott-Lite's 13-watt Portable lamp, for

example, should fit into anybody's workspace.

Adobe Gamma can calibrate and characterize your monitor:
Calibrating brings it into compliance with a standard; char-
acterizing creates a profile that describes how the monitor is
reproducing color.
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Very often somebody asks me: "Why don't my prints

look like what I see on my screen?" The answer,

Brutus, lies not in the stars, but in color management.

Once you're aware of the effects that different light-

ing has on output, you need to bring the separate ele-

ments of your computer system into color harmony.

Actually, your software and printer "think" the moni-

tor is displaying something that resembles the print.

The key is in knowing what the color of your image

is to begin with.

Color management begins with your monitor,

whether it is an LCD or a CRT display. The first step

is to use Adobe's Gamma software, included with

recent versions of Photoshop and Photoshop

Elements. The Gamma Control Panel lets you cali-

brate your monitor's contrast and brightness, gamma

(midtones), color balance, and white point. One way

to work with Gamma includes a step-by-step wizard

approach. Another, with more detailed information

for setting Gamma, can be found in Adobe's on-line

technical guides. The settings you obtain by working

with the Gamma control panel are used to create a

profile for your monitor, which can be used by color

management systems such as ColorSync for the Mac

OS and Microsoft's ICM for Windows.

With Adobe's Gamma, you have to make calibration

judgments based on charts that the software displays

on your monitor. In other words, you "eyeball" it,

which means the display can vary based on a number

of factors, including current lighting conditions.

Remember to calibrate your monitor on a regular

basis. Colors change as the monitor ages. While

Gamma isn't perfect, it will get you into the ballpark.

The better the color match between your monitor and

prints, the pickier you may become in narrowing

remaining differences. The secret in pursuing the

quest is not to hunt until the color dragon is slain, but

until you are satisfied with the match between moni-

tor and print.



Monaco Systems offers a device called an Optix XR colorimeter to help calibrate your LCD or CRT display. Photo
courtesy of X-Rite Photo Marketing.

There are a number of products you can purchase

separately that use hardware devices to measure the

color display with more accuracy than you can with

your eyes. These include the OPTIX XR from Monaco

by X-Rite, Eye-One Display from Gretag Macbeth,

and Colorvision's Spyder2. These colorimeters can

assist you in calibrating virtually any computer moni-

tor and will produce International Color Consortium

(ICC) profiles for Mac OS and Windows color man-

agement systems. This ColorVision Spyder2 is a device that attaches to
your LCD or CRT monitor, the way you may already
have stuck a stuffed Garfield there. When used with
ColorVision's software, such as PhotoCal or
OptiCal, it's relatively simple to calibrate your moni-
tor. Photo courtesy of Datacolor.com.
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Color Spaces
Another important task is to make sure your image-

processing program's color settings or color spaces are

appropriate (Photoshop > Color Settings). The

defaults may be fine, but not every photographer has

the same requirements. If you're unsure about set-

tings, you can contact a computer consultant or ask a

friend in your camera club what setting he or she uses.

The only selection I change is the Working Space. I

keep it set at Adobe RGB because that color space was

designed for printing with CMYK inks and includes a

wider range of colors (gamut) than sRGB (which was

developed to match a typical computer monitor's

color space and is the default for software on the

Windows platform). sRGB is also the color space

tucked inside most digital cameras, though some give

you a choice of sRGB or Adobe RGB. Check your

instruction manual for more information.

If you use Photoshop, try the default settings to see if they
work for you and make any changes based on experience.

Output Solutions
You may find after you've tried one of these monitor

calibration methods that, while your on-screen image

and output have become a much closer match, they

are not quite the same. (Don't forget differences in

reflective and transmitted light. In my own case, after

using Adobe Gamma and one of the color manage-

ment systems, the result was that output from my

printers looked better than it did on screen.)

If you're still not happy with your prints, it's time to

look at output profiling. A profile is a file that tells

your monitor (or any other device) to associate a

number based on specifications created by the

International Color Consortium (ICC) with a meas-

ured color. When your computer communicates color

information, it transmits this numerical data and spec-

ifies how those numbers should appear. Color man-

agement software takes this profile into consideration

and adjusts the device accordingly.

There are two kinds of people in this world of desk-

top darkrooms: Those who need output profiles and

those who don't. When using ink jet or even laser out-

puts as a proofing medium, prepress users know out-

put profiling is critical. Photographers using ink jet

output as the final product have different needs from

prepress users—all they generally need is for the

prints to match their monitor or their original vision

of how the image should appear—what Ansel Adams

called previsualization

Monaco EZcolor builds ICC monitor, scanner, and

printer profiles that produce accurate and consistent

color across devices and paper types. A wizard-like

interface guides users through the entire profiling

process. X-Rite also packages a color management

system that includes MonacoPROOF software and

X-Rite's Digital Swatchbook spectrophotometer.

Digital Swatchbook works with Macintosh or
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Baby Can I Drive Your Printer?

After connecting your printer to a computer, you need

to install software that lets the two devices communi-

cate. This is called "driver" software because it drives

the printer and makes it work.

With Mac OS computers, I prefer to insert the driver

software CD-ROM, and then double-click the icon to

make it work. With Microsoft Windows computers I've

found the most prudent way to install printer drivers is

by connecting the printer and restarting the computer.

This will cause Windows' Plug-and-Play feature to rec-

ognize that a new device is connected and will guide

you through the process of installing the driver. While

more experienced computer-users may feel they can

just install the hardware, then install the software, I've

often found that when working with some printers, not

using Windows' feature for plug-and-play installation

can create problems with partially installed software.

This is more trouble to fix than simply letting Windows

guide you through the installation in the first place.

Windows computers using measured spectropho-

tometer readings for color managing desktop comput-

ers. MonacoPROOF builds custom ICC profiles to let

you obtain accurate color from scanners, digital cam-

eras, monitors, printers, and even color copiers. The

software has an interface that guides users through

the profiling process and displays on-screen images

accurately to produce "soft" proofs. Some ink jet

printers bundle a copy of Monaco EZcolor Lite that

lets you create a single monitor profile for your system.

A great companion to ColorVision's Spyder2 is their

Profiler software, which color-manages desktop print-

ers. ColorVision provides target files that you output

on your printer. After you digitize that output with

'our scanner, Profiler RGB compares your image with

he original file and creates a unique profile for a spe-

ific paper/ink/printer combination.

f you're serious about color management, you might

vant to check out another ColorVision product.

)octorPro software lets you edit RGB and CMYK

printer files and uses Photoshop's capabilities to cre-

te adjustment scripts for editing output profiles,

including  color cast removal, opening shadows, cor-

ecting color mismatches, as well as adjusting bright-

Less, saturation, and contrast.
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onOne Software Intellihance Pro offers many image

enhancement capabilities, including multiple preview

panes and test strips that function similarly to a dark-

room test strip. Its digital test proof shows what the

image looks like with user-specified increments of

additional cyan, yellow, and magenta, or red, blue,

and green, so you can see how much of what color to

add in the printer driver to get a print that matches

your creative vision. This plug-in is available for

either Mac OS or Windows, and you can download

trial versions from the onOne Software website.

Check out all of these possibilities with an eye toward

affordability as well as compatibility with your sys-

tem and workflow.

Intellihance Pro has a feature that functions much like a traditional darkroom test strip.
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Ink on Paper

Four-color ink jet printers have the same cyan, yellow,

magenta, and black (C, Y, M, K) color process used by

commercial printing presses. To reproduce delicate

colors and textures such as skin tones and metallic

surfaces, six color printers usually add light cyan and

light magenta. Some Epson printers use seven or eight

colors, adding a light black, red, and/or gloss opti-

mizers for more depth and better monochrome repro-

duction. There is a trend to keep adding more colors.

Most desktop ink jet printers use one or two ink car-

tridges, but professional ink jet printers typically have

a separate cartridge for each color, something Canon

originally popularized for desktop photo printers.

Not all ink jet printers have the same ink formula-

tions. Some companies use pigmented-based inks for

their black ink cartridge and dye-based inks in their

color cartridges, while others use all dye-based inks or

all pigmented inks. Why do you care? Pigment inks

last longer but are not as vibrant; dye based inks are

colorful but have less longevity. On plain paper, dye

and pigmented inks mix easily because of this medi-

um's high ink absorption rate. But when printing on

coated stock, such as photo paper, printers with dif-

ferent types of inks turn off the black ink. (Black in the

output then becomes a composite of the CMY inks.)

Pigmented black ink is slightly better than dye-based

ink for printing sharp, dense, black text on plain

paper, and some manufacturers prioritize black text

over photo quality. Epson's UltraChrome inks, used in

some desktop and large format printers, are water

resistant and provide bright colors that are similar to

dye-based inks, while retaining pigmented ink's light-

fastness.

Because of these differences, selecting the paper type

in the printer driver is a critical step in achieving the

best possible output. Each type of paper shown in the

printer software driver has different characteristics

and different ink saturation. Thus, if you select the

wrong paper—either by accident or on purpose—

you'll get poor results.

So Waddaya Do to Get the Best
Results?

• Read the paper's instruction sheets. Find out which

driver settings are compatible with the paper and

what settings should produce the best results.

• Not every paper and ink combination works togeth-

er perfectly. Before making a big investment in

papers, purchase a sampler pack or small quantity of

a paper and make prints with your own test files

(more on how to do this later). Write notes about the

settings and paper on the back of the prints and put

them away in a file for future reference.

Printer manufacturers claim you get the best printing

and longest lasting results when using OEM (Original

Equipment Manufacturer) ink. There are less expen-

sive generic inks available, but using them will usual-

ly void your printer's warranty. I advise digital

imagers who want to work with archival, grayscale,

or generic ink sets to use separate printers. You may

want to shop for a great value on a discontinued

printer to use for your everyday work. Then you can

experiment with it to your heart's content with what-

ever bargain, recycled, or home-brewed ink you want.
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Here's a perfect example of the clarity and even tonality that a digi-
tal IR file offers over grainy film IR. This RAW file was made using
an IR-converted Canon EOS digital SLR. 1/30 second; f/22; ISO 200.
Photo ©Rick Sammon.

Rick Sammon is the host of two TV shows on the Do

It Yourself (DIY) cable/satellite network: Photography

Workshop and Digital Photography Workshop. He

has appeared on every major morning show and host-

ed episodes of the Canon "Photo Safari," on the

Outdoor Life Network. Show locales include

Galapagos, Belize, Botswana, and Thailand. On these

programs, Rick teaches celebrities how to take better

pictures. His former students include Maria

Conchita Alonzo, Dana Delany, John O'Hurley, and

Kelly Packard.

Rick is the author of 22 books and he has written

more than 1,000 articles on photography, travel,

wildlife, and conservation. Since 1990 he has been the

photography columnist for the Associated Press—a

column that garners about 10 million readers a week.

Rick also writes 12 travel features for the Associated

Press each year. All of these make Rick the most fre-

quently published photographer/writer in the world.

He also teaches at some of the most prestigious photo

workshops in the country: Maine Photographic

Workshop and Palm Beach Photo Workshop. In addi-

tion, Rick teaches workshops for Popular Photography

and Imaging magazines. These workshops (more than

20 in the past 5 years) have taken him to China, Costa

Rica, and throughout the United States. A member of

the Explorers Club, Rick has documented cultures in

Brazil, Nepal, India, Cuba, Thailand, Indonesia,

Papua New Guinea, and Costa Rica.

Rick's website, loaded with photos and information,

can be found at www.ricksammon.com
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Black and White in Color
One of the biggest challenges is making black-and-

white or monochromatic prints with IR image files.

This can be a problem with ink jet printers because

the monochrome prints they produce may be cool or

warm-toned (not neutral). With printers that use pig-

mented inks, metamerism (repeated banding) often

rears its colorful ugly head. You can always print

using the option for black ink only, and I have suc-

cessfully produced prints this way, but the results may

vary based on the characteristics of the original image.

To get truly continuous tone black-and-white prints,

you need a grayscale inkset. These inksets and com-

plimentary software are available from companies

such as Media Street and Lyson. These companies

offer archival quality inks that when used with

acid-free paper produce museum-quality giclee

images, which can be sold in art galleries

anywhere in the world. (See my note on page 139

about printer warranties.)

Printer manufacturers including Epson and HP have

started offering printers that will print monochrome

images using additional black ink cartridges. Epson

currently offers a printer with a maximum print size

of 13 x 19 inches (33 x 48 cm). It is delivered with nine

inks, including user-interchangeable Photo Black and

Matte Black cartridges. With an expanded inkset,

which includes black, light black, and light-light black

inks, the Epson R2400 when properly set produces

beautiful black and white prints that should last up to

200 years, and color prints that are fade-resistant for

up to 108 years.

With its full range of inks and Epson papers, the Epson R2400
produced a deliciously warm print of this monochrome IR image
file, which I like. However, if you don't care for the warmth, you
can use the Advanced section of the printer's driver to select
"Black and White Printing." In this case, only the printer's three
black inks will be used and the resulting prints will be as neutral
as Switzerland.

Printing Challenges
Sometimes it seems that different people can get dif-

ferent results from the same photographic file printed

with the same model ink jet printer on the same

paper. How is this possible? It is because one of these

photographers is getting the most out of the printer's

driver, while the others are just clicking the "Print"

button. I get questioned all the time by people who

ask why the prints made with my printer look differ-

ent from those that they're making with the same

brand and model of ink jet printer.

Here's some advice on a few steps you can take to

improve print quality before even starting to work

with your printer's software:

• Download the latest printer driver. Don't assume

that just because you unpacked a brand new printer

you'll have the latest driver. Oh contraire, mon frère .

It may be that some bugs have been fixed or support
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Check your printer manufacturer's website periodically to see if
there are driver updates.

has been added for new kinds of paper. Take the time

to go to your printer manufacturer's website and

download the most current driver, then install it.

• Clean the printer heads! Many times when photog-

raphers show me ink jet prints and ask what's wrong

with them, the answer is simply that the heads are

clogged. How do heads get dirty? If the printer is left

on and not used regularly, air gets into the heads and

clogs the ink. Make sure you have the printer turned

OFF unless you plan to use it. Plus, print heads get

dirty or clogged from not being used, so try to use

them every day. But mostly ink jet print heads get

dirty because that's what they do.

• Read the instruction manual. If you do this before

you make your first print, you'll discover there are

often several utilities that will help your printer pro-

duce the best possible results. With new Epson ink jet

printers, it's always a good idea to run both the Head

Alignment and Nozzle Check utilities before putting

Until somebody invents a self-cleaning head for ink jet
printers, you'll have to clean the heads periodically,
wasting precious Dom Perignon-priced ink in the
process. Hey, we used to scrub ovens by hand too;
now self-cleaning ovens make that chore a cinch. So
maybe somebody will figure out something similar
for ink jet printers.

in any "good" paper and making a print. Some new

printers run two head alignment tests, one for black

ink, the other for color. When you run these tests, it's

a good idea to evaluate the output using a high-quali-

ty magnifying loupe so that the feedback you provide

the utility is as accurate as possible.
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With most drivers, you can tweak the bright-

ness or contrast settings as well as the color

balance to get better results. Also, before mak-

ing a print, take a look at the advanced set-

tings that are available in the driver.

Get to Know Your Printer Driver

Some printers have built-in calibration routines that

set up the device after you've made your initial con-

nections. With most computer systems, these will like-

ly happen when the printer driver is installed, but

you may also need to recalibrate it from time to time.

HP's PhotoSmart Toolbox software, that's
bundled with their printers, lets you per-
form an automated series of diagnostics
and corrections, and when completed it
prints a test page.

No matter what brand of printer you use, its driver

software has a number of controls that allow you to

print on different kinds of paper, usually those offered

by the printer manufacturer. While you can use soft-

ware such as ColorVision's Profiler RGB to precisely

calibrate a specific kind of paper for your printer, the

driver itself provides controls that let you fine tune

the color, density, and contrast of your output. I liken

these controls to manually tweaking a color enlarger

in a traditional darkroom.

Printer drivers do more than just direct your comput-

er to send data to the printer. In most cases, the driv-

ers let you specify information about the kind of

paper you're using and how you want the finished

print to appear. You can simply pick the kind of paper

you're using, click the "Automatic" button, set the

slider to "Quality" and you'll usually get a pretty

good print, but it may not be the best possible print.

Just as you sometimes need to take your camera off

automatic mode and apply your photographic knowl-

edge and experience, you may want to take manual

control over the digital printing process.

Many ink jet printers' drivers allow full manual control of brightness, contrast, sat-
uration, and color. But before you work with these controls, it's a good idea to cre-
ate a personal test-print file.
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Making a Personal Test Print

Some ink jet printers automatically output a test page 

shortly after you connect to the computer and install 

the driver. While these pages may tell you that the 

printer is actually working, you may want more infor-

mation than that. One of the best ways to discover your 

printer's capabilities is to create and print a "personal" 

test print.

Comparing test prints is one of the best ways to eval-

uate different printers as well as different types of 

paper. I'm not talking about the kind of test prints seen 

in computer and electronics stores where you press a 

button and output rolls from the printer. While these 

files are usually optimized to make the

Inkjet Art Solutions' website 
contains several different test 
files. The one I use is the
PhotoDisc test file that contains 
many difficult-to-print colors 
and skin tones, plus a grayscale 
target, as well. Photo courtesy 
of Inkjet Art Solutions.

printer look good, the output can be compromised if the 

paper used is either the best or cheapest available. In 

this kind of setting, there are too many variables 

present to use these prints in comparing one printer to 

another. The key to comparing results from different 

printers or papers is to create a standardized test file 

and use it.

I have established two separate files that I use as stan-

dards to test new printers, inks, and papers. One is 

the PhotoDisc target that can be downloaded from Inkjet 

Art Solutions. The other is an image that I created with 

a digital SLR and contains reference colors such as 

skies, neutral grays, and skin tones. Whenever I get a 

new printer, new inks, or a new paper type, I run test 

prints to see if any adjustments are needed in the printer 

driver or software color settings to produce the desired 

results.

Your personal test file should reflect your typical image, 

such as an IR landscape. Use your favorite image-

processing program to save the photograph in a high-

resolution format such as TIFF. Instead of making the 

image 8 x 10 inches (20 x 25 cm), keep it around 5 x 7 

inches (13 x 18 cm). This will make the file size smaller 

and it will take less time to print. The file should then be 

saved on some kind of portable media, such as 

recordable CD/DVD, so it can be used in the future for 

testing new printers, inks, or papers.
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Start by printing the test image on your own printer, 

but you might also ask a friend if you can output it on 

their printer so you both can run the test to compare 

results. Use the test print with the printer driver's 

advanced settings and experiment with the slider set-

tings for brightness or contrast. Then take a look at 

color bias. Monochrome prints will clearly show color 

shifts attributable to the paper, inks, or printer 

because color shifts will be more apparent with a 

grayscale image. Working with your customized test 

file will let you know what driver settings will pro-

duce results you like and can also be a big help when 

evaluating different paper types or brands. After a lit-

tle testing, you'll find the paper and settings that will 

produce the optimum quality output from your printer.

Keep these test prints in a folder or some other type of 

dark storage for future reference. Write technical 

information on the back of the print, including what 

paper and ink were used, printer's settings, printer 

model, and the date print was made.

Ink Jet Papers

The ink jet paper you use can have a dramatic effect on 

the quality of your print. Printer manufacturers often 

insist that the best results will be produced by using 

their papers, and this advice often does give 

spectacular prints. But we wouldn't be photographers 

if we weren't looking for something different, would we? 

When working in a traditional darkroom, I used

Agfa, Ilford, and Kodak papers and would try to fit my 

choice of paper to the image. Now I keep papers from 

Epson, Media Street, Moab Paper, and others on hand, 

using the same concept of matching paper to the 

image's mood.

I like glossy shiny papers such as Epson Premium 

Glossy Photo Paper and Konica's Professional Glossy 

QP for photographs of automobiles and other shiny 

machines. Portraits look fabulous on Moab's Kayenta 

matte paper, but don't be bound by these dictums. 

Adorama offers a true heavyweight paper that's dou-

ble-sided matte and perfect for presentations and 

portfolios. Complementing their double-sided matte is 

a double-sided matte gloss and a royal satin, which 

has a fine "pearl" surface.

Experimenting with different kinds of papers with 

interesting textures and ink absorption characteristics 

can be fun, but judging from the questions I get during 

workshops, this is often where fun goes out of the 

process. The stock answer to keeping this from getting 

troublesome is that you should create a custom profile 

that is printer, ink, and paper specific. Many photog-

raphers who are new to working digitally don't want the 

hassle. But some forward-thinking paper companies 

are taking steps to put the creativity back into printing 

by producing generic profiles for each of their 

papers with different kinds of ink jet printers. I used to 

go to the art supply store to find papers with interesting 

textures, but now papermakers are offering interesting 

surfaces.

While the safest way to get the best possible results is 

to use the inks and papers produced by the printer 

manufacturer, it isn't always the way to the most 

exciting print. If you are still not satisfied with your 

prints, before running off to try other inks and papers,
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make sure that the printer itself is capable of pro-

viding the best possible results. It may not be. If your 

friends and colleagues are getting better results 

than you, the place to start trying to improve is the 

printer driver. Only after you've first optimized the 

printer to produce the best possible results 

should you start looking for ways to improve 

your printer output.

Long Lasting Prints

The best way to ensure a print's longevity is to take 

a few simple steps:

• Allow prints to dry for twenty-four hours before 

framing them. Avoid framing when humidity is 

high because condensation can form behind the 

glass. Don't hang prints in direct sunlight or display 

prints outdoors.

• Allow prints to dry for at least fifteen minutes 

before stacking them. Place a sheet of plain paper (I use 

copier paper) between the individual prints when 

stacking. Allow a full day for prints to dry before 

removing the separator sheets. And don't force-dry 

prints with a hair dryer.

• Keep prints away from sources of ozone. This includes 

such things as computer monitors, television, air 

cleaners, or high voltage electricity. Don't store prints, 

or digital paper for that matter, where they will be 

exposed to chemicals such as in a traditional dark-

room.

• Use acid-free archival sleeves when storing prints in 

photo albums.

• Finally, visit Wilhelm Research's website (www.

wilhelm-research.com) often. This site is regularly 

updated with information on the stability and 

longevity of new inks and papers.
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Profiles In Infrared: Steve and Aaron Cathcart

Steve and Aaron Cathcart (www.cathcartphoto.com) 

are a father and son who have been photographing 

weddings in the Estes Park, Colorado area for more 

than ten years. Steve is a second-generation photogra-

pher, which makes his son Aaron a third-generation 

photographer.

The idea of shooting infrared appealed to Aaron, so 

he bought an IR filter for his Nikon digital SLR and 

started to experiment. He enjoys shooting IR in the 

Colorado mountains, and since most people are not 

familiar with infrared photography, his unusual-look-

ing landscapes are something different to show to his

clients. The photos have a dream-like quality that can-

not be totally duplicated, no matter how much creative 

work is applied to an image in Photoshop.

Aaron also shoots IR at certain weddings, especially if a 

composition includes foliage. Some brides specifically 

ask for infrared photos and love the results. Aaron 

acknowledges that one key to IR success "is to shoot lots 

of photos and bracket. But," he adds with jokingly, "I 

don't want to give away all my secrets."

Photo ©Aaron Cathcart
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Both of these IR images were shot by Aaron Cathcart in Estes Park, Colorado using a Nikon D1X with a Wratten #87 filter. In 
the photo above, some of the trees in the foreground are deciduous and are rendered in white, while the trees in the 
background are evergreens that reflect very little IR. The sky lacks the dark tones shown in Aaron's other image here (see left), 
showing how differently IR photography will interpret a scene based on its content of IR wavelengths. Photo ©Aaron Cathcart.
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WEBSITE RESOURCES

Sensor/Camera Cleaning

Intelligent Mobile Solutions UK (www.intemos.com) 

Photograph ic  So lu t ions  (www.photosol .com) 

Visible Dust (www.visibledust.com)

Dedicated IR Cameras and Camera Conversion

Hutech Astronomical Products (www.sciencecenter.
net/hutech/irphoto/ir.htm)

IR Guy (www.irdigital.net) 

LDP (www.maxmax.com)

Life Pixel (www.lifepixel.com)

Infrared Filters
Cokin (www.cokin.com)

Eastman Kodak Company (www.kodak.com) 

Heliopan (www.hpmarketingcorp.com)

Hoya (www.hoyaoptics.com)

Lee (leefilters.com)

Schneider Optics (B+W) (www.schneideroptics.com) 

Singh Ray (www.singh-ray.com)

Tiffen (www.tiffen.com)

IR Information, Resources
and General Photographic Sites

Blue Pixel (www.bluepixel.net)

Digital Infrared Resource Page (folk.
uio.no/gisle/photo/ir.html)

Digital Photography For What It's Worth (www.
dpfwiw.com/ir.htm)

Digital Photography Review (www.dpreview.com) 

Electronic Photo Imaging (www.epi-centre.com) 

Thom Hogan  (www.bythom.com/infrared.htm) 

Imaging Resource (www.imaging-resource.com) 

Lensmate On Line (www.lensmateonline.com) 

Luminous Landscape (www.luminous-landscape.com)

Macintosh Maintenance & Diagnostics (www.
macmdcare.com)
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Willem-Jan Markerink (www.al.nl/phomepag/ 
markerink/mainpage.htm)

Megapixel (www.megapixel.net)

PC Photo Magazine (www.pcphotomag.com)

Ken Rockwell (www.kenrockwell.com/tech/ir.htm)

Rocky Mountain Film Lab (www.
rockymountainfilm.com)

Steve's Digicams (www.steves-digicams.com) Vivid 

Light Photography (www.vividlight.com)

Wilhelm Imaging Research (www.wilhelm-
research.com)

Wet Pixel (www.wetpixel.com)

A n d r z e j  W r o t n i a k  
(www.wrotniak.net/photo/infrared)

Image-Processing Software Products 
About Digicam (http://aboutdigicam.com)

Adobe Studio Exchange 
(http://share.studio.adobe.com)

Adobe Systems (www.adobe.com)

Alien Skin Software (www.alienskin.com)

Andromeda Software 
(www.andromeda.com)

ArcSoft (www.arcsoft.com)

Auto FX Software (www.autofx.com)

Corel (www.corel.com)

Craig's Actions (www.craigsactions.com) 

Eastman Kodak Company

Austin Development Center (www.asf.com) Flaming 

Pear Software (www.flamingpear.com) Imagenomic 

(www.imagenomic.com)

The Imaging Factory (www.theimagingfactory.com) 

Fred Miranda (www.fredmiranda.com) Nik Software 

(www.niksoftware.com) on One Software (www.

ononesoftware.com) PictureCode (www.picturecode.

com) Pixel Genius (www.pixelgenius.com) Power 

Retouche (www.powerretouche.com) Silver Oxide

(www.silveroxide.com) Ulead Systems 

(www.ulead.com) Visual Infinity (www.visinf.com)

Display: Calibration, Color Management, and 
Scanning Products

GretagMacbeth (www.gretagmacbeth.com) 

DisplayMate Technologies (www.displaymate.com) 

ColorVision Datacolor (www.colorvision.com)

International Color Consortium (ICC) 
(www.color.org)

Monaco by X-Rite (www.xritephoto.com)

Inkjet Art Solutions (www.inkjetart.com/custom)

LaserSoft Imaging (www.silverfast.com) 

Ott-Lite Technology (www.ottlite.com)

Inkjet Printing
Eastman Kodak Company (www.kodak.com) 

Canon (www.canon.com)

Dell (www.dell.com)

Epson (www.epson.com)

Hewlitt-Packard Development (www.hp.com) 

Lexmark International (www.lexmark.com)

Contributors
Aaron Cathcart (www.cathcartphoto.com) Eric 

Cheng (littp://echeng.com)
Brody Dezember (www.dezemberphoto.com) 

Reggie Linsao (www.boomslice.com)

Danny Ngan (www.dannyngan.com)

Paul Nuber (www.pozim.com)

Rick Sommon (www.ricksammon.com) 

Carl Schofield (www.schophoto.com) 

Chip Talbert (www.chiptalbert.com)

Robert Williams (www.robwilliams.ca)
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aberration: An optical flaw in a lens that causes the 
image to be distorted or unclear.

Adobe Photoshop: Professional-level image-process-
ing software with extremely powerful filter and color-
correction tools. It offers features for photography, 
graphic design, web design, and video.

Adobe Photoshop Elements: A limited version of 
the Photoshop program, designed for the avid pho-
tographer. The Elements program lacks some of the 
more sophisticated controls available in Photoshop, 
but it does have a comprehensive range of image-
manipulation options, such as cropping, exposure and 
contrast controls, color correction, layers, adjustment 
layers, panoramic stitching, and more.

AE: See automatic exposure.

AF: See automatic focus.

AI: Automatic Indexing.

aliasing: Jagged edges or a "stair step" appearance that 
become visible, especially along diagonal lines, in 
digital images and graphic displays due to the shape of 
pixels.

ambient light: See available light.

analog: Information presented in continuous form. A 
traditional photographic print is an analog form, but 
when this same image is scanned and converted into 
digital form, it is made up of bits.

angle of view: The area seen by a lens, usually meas-
ured in degrees across the diagonal of the film frame.

anti-aliasing: A technique that reduces or eliminates 
the jagged appearance of lines or edges in an image.

aperture: The opening in the lens that allows light to 
enter the camera. Aperture is usually described
as an f/number. The higher the f/number, the smaller 
the aperture; and the lower the f/number, the 
larger the aperture.

Aperture-priority mode: A type of automatic expo-
sure in which you manually select the aperture and 
the camera automatically selects the shutter speed.

artifact: Information that is not part of the scene but 
appears in the image due to technology. Artifacts can 
occur in film or digital images and include increased 
grain, flare, static marks, color flaws, noise, etc.

artificial light: Usually refers to any light source that 
doesn't exist in nature, such as incandescent, fluores-
cent, and other manufactured lighting.

automatic exposure: When the camera measures 
light and makes the adjustments necessary to create 
proper image density on sensitized media.

automatic flash: An electronic flash unit that reads 
light reflected off a subject (from either a preflash or 
the actual flash exposure), then shuts itself off as soon 
as ample light has reached the sensitized medium.

automatic focus: When the camera automatically 
adjusts the lens elements to sharply render the subject.

Av: Aperture Value. See Aperture-priority mode.

available light: The amount of illumination at a 
given location that applies to natural and artificial light 
sources but not those supplied specifically for photogra-
phy. It is also called existing light or ambient light.

backlight: Light that projects toward the camera from 
behind the subject.

bit depth: The number of bits per pixel that deter-
mines the number of colors the image can display. 
Eight bits per pixel is the minimum requirement for a 
photo-quality color image.

bitmap: A computer-screen display made up of indi-
vidual pixels.

bounce light: Light that reflects off of another surface 
before illuminating the subject.

bracketing: A sequence of pictures taken of the same 
subject but varying one or more exposure settings, 
manually or automatically, between each exposure.

brightness: A subjective measure of illumination. See 
also, luminance.

buffer: Temporarily stores data so that other pro-
grams, on the camera or the computer, can continue 
to run while data is in transition.

built-in flash: A flash that is permanently attached to 
the camera body. The built-in flash will pop up and fire 
in low-light situations when using the camera's 
automated exposure settings.

built-in meter: A light-measuring device that is 
incorporated into the camera body.

byte: A single group of eight bits that is processed as 
one unit. See also, bit.



card reader: Device that connects to your computer 
and enables quick and easy download of images from 
memory card to computer.

CCD: Charge Coupled Device. This is a common digital 
camera sensor type that is sensitized by applying an 
electrical charge to the sensor prior to its exposure to 
light. It converts light energy into an electrical impulse.

chromatic aberration: Occurs when light rays of dif-
ferent colors are focused on different planes, causing 
colored halos around objects in the image.

chrominance: A component of an image that express-
es the color (hue and saturation) information, as 
opposed to the luminance (lightness) values.

chrominance noise: A form of artifact that appears 
as a random scattering of densely packed colored "
grain." See also, luminance and noise.

close-up: A general term used to describe an image 
created by closely focusing on a subject. Often 
involves the use of special lenses or extension tubes. 
Also, an automated exposure setting that automatically 
selects a large aperture (not available with all cameras).

CMOS: Complementary Metal Oxide Semiconductor. 
Like CCD sensors, this sensor type converts light into 
an electrical impulse. CMOS sensors are similar to 
CCDs, but allow individual processing of pixels, are 
less expensive to produce, and use less power. See also, 
CCD.

CMYK mode: Cyan, magenta, yellow, and black. This 
mode is typically used in image-processing applica-
tions when preparing an image for printing.

color balance: The average overall color in a repro-
duced image. How a digital camera interprets the 
color of light in a scene so that white or neutral gray 
appear neutral.

color cast: A colored hue over the image often 
caused by improper lighting or incorrect white 
balance settings. Can be produced intentionally for 
creative effect.

color depth: See bit depth.

color space: A mapped relationship between colors 
and computer data about the colors.

CompactFlash (CF) card: One of the most widely 
used removable memory cards.

compression: A method of reducing file size 
through removal of redundant data, as with the 
JPEG file format.

contrast: The difference between two or more tones 
in terms of luminance, density, or darkness.

critical focus: The most sharply focused plane within 
an image.

cropping: The process of extracting a portion of the 
image area. If this portion of the image is enlarged, 
resolution is subsequently lowered.

dedicated flash: An electronic flash unit that talks 
with the camera, communicating things such as flash 
illumination, lens focal length, subject distance, and 
sometimes flash status.

default: Refers to various factory-set attributes or fea-
tures, in this case of a camera, that can be changed by 
the user but can, as desired, be reset to the original 
factory settings.

depth of field: The image space in front of and 
behind the plane of focus that appears acceptably 
sharp in the photograph.

diaphragm: A mechanism that determines the size of 
the lens opening that allows light to pass into the 
camera when taking a photo.

digital zoom: The cropping of the image at the sen-
sor to create the effect of a telephoto zoom lens. The 
camera interpolates the image to the original resolu-
tion. However, the result is not as sharp as an image
created with an optical zoom lens because the cropping 
of the image reduced the available sensor resolution.

diopter: A measurement of the refractive power of a 
lens. Also, it may be a supplementary lens that is 
defined by its focal length and power of magnification.

download: The transfer of data from one device 
to another, such as from camera to computer or 
computer to printer.

dpi: Dots per inch. Used to define the resolution of a 
printer, this term refers to the number of dots of ink 
that a printer can lay down in an inch.

DVD: Digital Video Disc. These discs store more 
information that CDs.

electronic flash: A device with a glass or plastic tube 
filled with gas that, when electrified, creates an 
intense flash of light. Also called a strobe. Unlike a 
flash bulb, it is reusable.

EV: Exposure value. A number that quantifies the 
amount of light within an scene, allowing you to 
determine the relative combinations of aperture and 
shutter speed to accurately reproduce the light levels 
of that exposure.
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EXIF: Exchangeable Image File Format. This format 
is used for storing an image file's interchange 
information.

exposure: When light enters the camera and reacts 
with the sensitized medium. The term can also
refer to the amount of light that strikes the light sen-
sitive medium.

exposure meter: See light meter.

file format: The form in which digital images are 
stored and recorded, e.g., JPEG, RAW, TIFF, etc.

filter: Usually a piece of plastic or glass used to con-
trol how certain wavelengths of light are recorded. A 
filter absorbs selected wavelengths, preventing them 
from reaching the light sensitive medium. Also, soft-
ware available in image-processing computer pro-
grams can produce special filter effects.

FireWire: A high speed data transfer standard that 
allows outlying accessories to be plugged and 
unplugged from the computer while it is turned on. 
Some digital cameras and card readers use FireWire to 
connect to the computer. FireWire transfers data faster 
than USB.

firmware: Software that is permanently incorporated 
into a hardware chip. All computer-based equipment, 
including digital cameras, use firmware of some kind.

flare: Unwanted light streaks or rings that appear in 
the viewfinder, on the recorded image, or both. It is 
caused by extraneous light entering the camera dur-
ing shooting. Diffuse flare is uniformly reflected light 
that can lower the contrast of the image. Zoom lenses 
are susceptible to flare because they are comprised of 
many elements. Filters can also increase flare. Use of a 
lens hood can often reduce this undesirable effect.

f/number: See f/stop.

focal length: When the lens is focused on infinity, it 
is the distance from the optical center of the lens to 
the focal plane.

focal plane: The plane on which a lens forms a sharp 
image. Also, it may be the film plane or sensor plane.

focus: An optimum sharpness or image clarity that 
occurs when a lens creates a sharp image by converg-
ing light rays to specific points at the focal plane. The 
word also refers to the act of adjusting the lens to 
achieve optimal image sharpness.

f/stop: The size of the aperture or diaphragm opening 
of a lens, also referred to as f/number or stop. The 
term stands for the ratio of the focal length (f) of the 
lens to the width of its aperture opening. (f/1.4 =

wide opening and f/22 = narrow opening.) Each stop 
up (lower f/number) doubles the amount of light 
reaching the sensitized medium. Each stop down (
higher f/number) halves the amount of light reaching 
the sensitized medium.

full-frame: The maximum area covered by the sensi-
tized medium.

full-sized sensor: A sensor in a digital camera that 
has the same dimensions as a 35mm film frame (24 x 
36 mm).

gamma: A measurement of the contrast that affects 
midtones in an image. Gamma settings differ between 
operating systems for Macintosh (1.8 setting) and 
Windows (2.2).

gamut: The full range of colors that a printer, moni-
tor, or other computer peripheral can accurately 
reproduce. Different devices have different gamuts, 
requiring the need for color management systems to 
provide consistency between them.

GB: See gigabyte.

gigabyte: Just over one billion bytes.

gray card: A card used to take accurate exposure 
readings. It typically has a white side that reflects 90% 
of the light and a gray side that reflects 18%.

gray scale: A successive series of tones ranging 
between black and white, which have no color.

hard drive: A contained storage unit made up of 
magnetically sensitive disks.

histogram: A graphic representation of image tones.

hot shoe. An electronically connected flash mount on 
the camera body. It enables direct connection between 
the camera and an external flash, and synchronizes the 
shutter release with the firing of the flash.

ICC: The International Color Consortium, a group of 
eight large manufacturers in the computer and digital 
imaging industries. The consortium works to a 
dvance a common foundation for cross-platform color 
communication and has established base-level stan-
dards and protocols in the form of ICC Profile Format 
specifications.

image-editing program: See image-processing 
program.

image-processing program: Software that allows for 
image alteration and enhancement.



interpolation: A process used to increase image reso-
lution by creating new pixels based on existing pixels. 
The software intelligently looks at existing pixels and 
creates new pixels to fill the gaps and achieve a higher 
resolution.

IS. Image Stabilization: A technology that reduces 
camera shake and vibration.

ISO: A term for industry standards from the 
International Organization for Standardization. When 
an ISO number is applied to film, it indicates the rela-
tive light sensitivity of the recording medium. Digital 
sensors use film ISO equivalents, which are based on 
enhancing the data stream or boosting the signal.

JPEG: Joint Photographic Experts Group. A lossy 
compression file format that works with any comput-
er and photo software. JPEG examines an image for 
redundant information and then removes it. It is a 
variable compression format because the amount of 
leftover data depends on the detail in the photo and 
the amount of compression. At low compression/high 
quality, the loss of data has a negligible effect on the 
photo. However, JPEG should not be used as a 
working format—the file should be reopened and saved 
in a format such as TIFF, which does not compress 
the image.

KB: See kilobyte.

kilobyte: Just over one thousand bytes.

layer: A tool in image-processing programs that cre-
ates separate versions of an image, each of which can 
be manipulated independently. The separate layers 
can then be used to form a composite image.

LCD: Liquid Crystal Display. A flat screen with two 
clear polarizing sheets on either side of a liquid crystal 
solution. When activated by an electric current, the 
LCD causes the crystals to either pass through or 
block light in order to create a colored image display.

lens: A piece of optical glass on the front of a camera 
that has been precisely calibrated to allow focus.

lens hood: Also called a lens shade, it is a short tube 
that can be attached to the front of a lens to reduce 
flare. It keeps undesirable light from reaching the 
front of the lens and also protects the front of the lens.

light meter: Also called an exposure meter, it is a 
device that measures light levels and calculates the 
correct aperture and shutter speed.

lossless: Image compression in which no data is lost.

lossy: Image compression in which data is lost and, 
thereby, image quality is lessened. This means that the 
greater the compression, the lesser the image quality.

low-pass filter: A filter designed to remove elements 
of an image that correspond to high-frequency data, 
such as sharp edges and fine detail, to reduce the effect 
of moire. See also, moire.

luminance: A term used to describe directional 
brightness. It can also be used as luminance noise, 
which is a form of noise that appears as a sprinkling 
of black "grain." See also, brightness, chrominance, 
and noise.

macro lens: A lens designed to be at top sharpness 
over a flat field when focused at close distances and 
reproduction ratios up to 1:1.

main light: The primary or dominant light source. It 
influences texture, volume, and shadows.

Manual exposure mode: A camera operating mode 
that requires the user to determine and set both the 
aperture and shutter speed. This is the opposite of 
automatic exposure.

mask: A method in image-processing programs to 
protect all or parts of an image from enhancement. 
Cutouts or openings in the mask allow unmasked por-
tions of the image to be accessible for manipulation.

MB: See megabyte.

megabit: One million bits of data. See also, bit. 

megabyte: Just over one million bytes.

megapixel: A million pixels.

memory: The storage capacity of a hard drive or 
other recording media.

memory card: A solid state removable storage medium 
used in digital devices. It can store still images, moving 
images, or sound, as well as related file data. There are 
several different types, including CompactFlash, 
SmartMedia, and xD, or Sony's proprietary Memory 
Stick, to name a few. Individual card capacity is 
limited by available storage as well as by the size of the 
recorded data (determined by factors such as image 
resolution and file format). See also, CompactFlash (
CF) card, file format.

menu: A listing of features, functions, or options dis-
played on a screen that can be selected and activated 
by the user.

microdrive: A removable storage medium with mov-
ing parts. They are miniature hard drives based on the 
dimensions of a CompactFlash Type II card. 
Microdrives are more susceptible to the effects of 
impact, high altitude, and low temperature than solid-
state cards are. See also, memory card.
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midtone: The tone that appears as medium bright-
ness, or medium gray tone, in a photographic print.

moire: Moire appears as a wavy pattern over the 
image and occurs when the subject has more detail 
than the resolution of the digital camera can capture.

noise: The digital equivalent of grain. It is often 
caused by a number of different factors, such as a
high ISO setting, heat, sensor design, etc. Though 
usually undesirable, it may be added for creative 
effect using an image-processing program. See also, 
chrominance noise and luminance.

normal lens: See standard lens.

operating system (OS): The system software that 
provides the environment within which all other soft-
ware operates.

overexposed: When too much light is recorded with 
the image, causing the photo to be too light in tone.

perspective: The effect of the distance between the 
camera and image elements upon the perceived size 
of objects in an image. It is also an expression of this 
three-dimensional relationship in two dimensions.

pixel: Derived from picture element. A pixel is the 
base component of a digital image. Every individual 
pixel can have a distinct color and tone.

plug-in: Third-party software created to augment an 
existing software program.

pre-flashes: A series of short duration, low intensity 
flash pulses emitted by a flash unit immediately prior 
to the shutter opening. These flashes help the TTL light 
meter assess the reflectivity of the subject.

profile: A file that "describes" how a device (e.g. camera, 
monitor, printer) associates color information with 
specifications created by the International Color Consortium 
(ICC).

Program mode: In Program exposure mode, the 
camera selects a combination of shutter speed and 
aperture automatically.

RAM: Random Access Memory. A computer's memo-
ry capacity, directly accessible from the central pro-
cessing unit.

RAW: An image file format that has little or no inter-
nal processing applied by the camera. It contains 12-
bit color information, a wider range of data than 8-bit 
formats such as JPEG.

RAW+JPEG: An image file format that records two 
files per capture; one RAW file and one JPEG file.

resolution: The amount of data available for an 
image as applied to image size. It is expressed in pix-
els or megapixels, or sometimes as lines per inch on a 
monitor or dots per inch on a printed image.

RGB mode: Red, Green, and Blue. This is the color 
model most commonly used to display color images 
on video systems, film recorders, and computer 
monitors. It displays all visible colors as 
combinations of red, green, and blue. RGB mode is 
the most common color mode for viewing and 
working with digital files onscreen.

saturation: The degree to which a color of fixed tone 
varies from the neutral, grey tone; low saturation 
produces pastel shades whereas high saturation 
gives pure color.

sharp: A term used to describe the quality of an 
image as clear, crisp, and perfectly focused, as 
opposed to fuzzy, obscure, or unfocused.

short lens: A lens with a short focal length—a wide-
angle lens. It produces a greater angle of view than 
you would see with your eyes.

shutter: The apparatus that controls the amount of 
time during which light is allowed to reach the sensi-
tized medium.

Shutter-priority mode: An automatic exposure 
mode in which you manually select the shutter speed 
and the camera automatically selects the aperture.

Single-lens reflex: See SLR.

SLR: Single-lens reflex. A camera with a mirror that 
reflects the image entering the lens through a pen-
taprism or pentamirror onto the viewfinder screen. 
When you take the picture, the mirror reflexes out of 
the way, the focal plane shutter opens, and the image 
is recorded.

small-format sensor: In a digital camera, this 
sensor is physically smaller than a 35mm frame of 
film. The result is that standard 35mm focal lengths 
act like longer lenses because the sensor sees an angle 
of view smaller than that of the lens.

standard lens: Also known as a normal lens, this is a 
fixed-focal-length lens usually in the range of 45 to 
55mm for 35mm format (or the equivalent range for small-
format sensors). In contrast to wide-angle or telephoto 
lenses, a standard lens views a realistically proportionate 
perspective of a scene. 
 
 



stop down: To reduce the size of the diaphragm 
opening by using a higher f/number.

stop up: To increase the size of the diaphragm open-
ing by using a lower f/number.

telephoto lens: A lens with a long focal length that 
enlarges the subject and produces a narrower angle of 
view than you would see with your eyes.

thumbnail: A small representation of an image file 
used principally for identification purposes.

TIFF. Tagged Image File Format. This popular digital 
format uses lossless compression.

tripod: A three-legged stand that stabilizes the camera 
and eliminates camera shake caused by body movement 
or vibration. Tripods are usually adjustable for height 
and angle.

TTL: Through-the-Lens, i.e. TTL metering. 

Tv: Time Value. See Shutter-priority mode.

USB: Universal Serial Bus. This interface standard 
allows outlying accessories to be plugged and 
unplugged from the computer while it is turned on. 
USB 2.0 enables high-speed data transfer.

vignetting: A reduction in light at the edge of an 
image due to use of a filter or an inappropriate lens 
hood for the particular lens.

viewfinder screen: The ground glass surface on 
which you view your image.

wide-angle lens: A lens that produces a greater angle of 
view than you would see with your eyes, often causing 
the image to appear stretched. See also, short lens.

zoomlens: A lens that can be adjusted to cover a wide 
range of focal lengths.
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AboutDigicam 115, 150
Actions 84, 100-101, 117-120, 151
adapter ring 48, 58
Adjustment Layer 81-83, 98, 122, 123, 125
Adobe Photoshop 17, 26, 39, 80, 88, 91, 98, 100, 101, 

122, 134
Adobe Photoshop Elements 80, 134
Adobe Studio Exchange 101, 117, 118, 119, 150
Alien Skin 111, 150 
Andromeda 97, 150
aperture scale 32, 34, 36, 37, 48
artifact 64, 106, 107 
Auto F/X 104, 151

B
B+W 44, 50, 52, 53, 56, 57, 150
Bayer pattern 62, 63
black-and-white mode 22, 24, 35, 37, 46, 49, 58, 64, 66, 96 
blur 37, 52, 102, 107, 109
bracketing 16, 36-37, 38

C
C-41 122, 127
calibration (see monitor calibration)
camera capability (see IR capability)
camera conversion (see IR-converted camera) 
Camera RAW 26
Cathcart, Aaron 19, 31, 77, 148-149, 151 
CCD sensor (see sensor, CCD)
Channel Mixer 68-69, 81
Cheng, Eric 108-109, 151
chromatic aberration 31
cleaning

filter 48
printer heads 143
sensor 21, 150

clipping 38
CMOS sensor (see sensor, CMOS)
Cokin 20, 37, 40, 48, 50, 53, 54, 58, 96, 150 
color channel 68-69, 72, 124, 125
color correction 46, 81, 134, 137
color IR images 66, 69, 116, 120
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color temperature (see also white balance) 133 
colorimeter 135
ColorVision 135, 137, 144, 151 
compression 64, 105, 106, 107
converted camera (see IR-converted camera)
Corel 80, 151
Craig's Actions 100, 120, 151 
creative edges 102-104
cross processing 119, 122, 127
cut-off filter (see internal infrared cut-off filter)

D
depth of field 32, 35, 36, 48, 55 
depth-of-field scale 32, 34 
Dezember, Brody 28-29, 151 
Digital GEM Professional 106 
dpi (dots-per-inch) 131
drivers (see printer driver) 
duotone 88-90

E
E-6 122, 127
Eastman Kodak Company 48, 50, 106, 150 
electronic viewfinder (EVF) 35
Elements (see Adobe Photoshop Elements) exposure 
compensation 36, 39, 40, 42, 43, 47, 49, 94 exposure (
metering) 18, 30, 35, 36-39, 55, 62 Extensis 102-104, 
151
external infrared (IR) filter (see filters, external 

infrared)

F
false color IR (see also faux IR) 24
faux IR (see also false color IR) 15, 17, 46, 111-127 
file formats 24-26
filters

external infrared 14, 16, 18, 20, 22, 23, 31, 32, 35, 
46-60, 66

007 20, 37, 50
#25 48, 50, 54, 56 
25A 16, 51
R72 47, 50, 51, 61, 68, 70, 74, 75, 84, 94, 128, 129 
#87 19, 31, 50, 52, 54, 77, 149
#87C 50, 54
#88A 51
#89B 51
RM90 50, 51
092 50, 51, 52, 57
093 44, 51, 57
I-Ray 51, 54, 55, 59
gelatin 48, 53
glass 48, 49, 53, 54
square 48, 53, 54

Filter Gallery 91-92
flare 52
focal length 31, 34
focusing 18, 30-35, 43, 48

focusing index 32
focusing mark (see infrared focusing mark) 
Foveon (see sensors, Foveon)
frames (see creative edges)

G
Gamma 134, 136
gelatin filters (see filters, gelatin)
glass filters (see filters, glass)
Grain Surgery 106
Gretag Macbeth 135, 151
grayscale (see also monochrome) 24, 66-69, 76, 87, 88, 

98, 104, 146

H
hand coloring 10, 98-99
Heliopan 49, 51, 52, 53, 150
histogram 36, 38-39, 42, 64, 83
hot mirror (see also internal infrared cut-off filter) 18, 

20, 108
Hoya 47, 50, 51, 61, 68, 70, 75, 84, 94, 128, 129, 150 
hyperfocal distance 32-34, 35, 43, 48

I
ICC (see International Color Consortium)
IIRC (see internal infrared cut-off filter)
image processing software (programs) 24, 30, 39, 70,

76, 80, 91, 100, 102
infrared (IR) film 14, 17, 44, 78, 79, 94, 111, 112, 119, 122 
infrared focusing mark 32, 48
infrared wavelengths/radiation 13-15, 20, 30, 31, 32, 

36, 39-40, 43, 46, 48, 50, 55, 56
spectrum 15, 50, 51

inks 88, 126, 127, 130, 131, 132, 139, 142-143, 145, 146, 147
internal infrared cut-off filter (IIRC) (see also hot 

mirror) 18, 21, 22, 23, 34, 52, 55
International Color Consortium 135, 136, 137, 151 
IR capability (of camera) 18, 20, 111
IR-converted camera 22-23, 24, 26, 35, 116, 150 
ISO 18, 36, 37, 106, 107

J
JPEG 24, 64, 106, 107

K
Kelvin (see color temperature)
Kodak Ektachrome 15, 16, 79, 188
Kodak Wratten Gelatin ® Filters 19, 31, 48, 50, 52, 56,

77, 108, 149

L
layer mask 81
Layers 80-83, 84, 86, 87, 88, 99, 122, 123
LCD screen (monitor) 35, 36, 38, 39, 55, 57, 64 
Lee 51, 53, 54, 150
lens hood 48, 52
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lenses 31, 32, 34, 48, 52, 53, 56, 59 
light (see visible light)
Linsao, Reggie 84, 128-129, 151

M
Manual (M) exposure mode 35, 36, 39, 55 
memory card 17, 24, 76, 116
micro piezo printing 131
modified camera (see IR-converted camera) 
modular filter system 48, 53-54
Monaco Systems 135, 136, 137, 151
monitor calibration 134, 136, 151
monochrome 26, 46, 66-73, 139, 142, 146
mounting ring (see also screw-mount) 48, 53, 56

N
nanometer (nm) 15
near infrared (NIR) 15, 50, 51, 74, 108 
Ngan, Danny 122, 126-127, 151
Nik Software 70, 71, 96, 97, 111-113, 127, 151 
noise 36, 105
noise reduction 106-107
Noise Ninja 107
Noise Reduction Pro 106
Noiseware 107
Nuber, Paul 44-45, 151

0
Ott-Lite 133, 134, 151

P
Paint Shop Pro 80
paper (printing) 130-131, 132, 136, 139, 142-145, 146-147 
Photolmpact 80
Photoshop (see Adobe Photoshop) 
Picasa 80
Pixel Genius 87, 151
pixels 61, 106
plug-ins 70-72, 84-88, 106-107, 111-115, 127 
Power Retouche 72-73, 151
printer driver 130, 137-139, 142-144, 145, 146, 147 
printer heads 131, 143
printing 130-147
profile (profiling) 134, 136-137, 146 
pseudo color IR (see false color IR)

R
RAW 24, 26, 98, 140
reflectance (reflectivity) 30, 43, 57, 66, 114 
remote control test 21-22
resolution

image 64, 131, 145
printer 131, 132
scanner 78

retrofitted camera (see IR-converted camera) 
RGB 46, 62, 88, 98, 136

S
Sabattier Effect 97
Sammon, Rick 8, 13, 140-141, 151
scanning 78-79, 106, 107, 136, 137, 151
Schneider Optics (see B+W)
Schofield, Carl 74-75, 131, 151
screw-mount filters 49
sensor, imaging 9, 15, 18, 21, 34, 46, 48, 52, 55, 57, 

62-63, 66, 105
CCD 18, 63
CMOS 18, 63
Foveon 63
Super CCD SR II 63 

Silver Oxide 114, 151 
SilverFast 78, 151
Singh Ray 51, 54, 55, 150
solarization 96, 97

T
Talbert, Chip 60-61, 151
test prints 134, 13, 145-146 TIFF 
24, 26, 64, 66, 70, 99, 145 Tiffen 
51, 52, 54, 108, 150 tripod 22, 
35, 55, 108
toning 30, 86-90
transmission rates 46, 50-51 
tritone 88, 90

U
Ulead 80, 151
ultraviolet 15, 17, 51 
UV (see filters, UV)

V
visible light 9, 14, 15, 18, 22, 31, 46, 48, 50, 51, 54, 56, 

57, 60, 108
spectrum 51

W
white balance 23, 26, 83, 128
Williams, Robert 94-95, 151
woodcut effect 97 
Wratten system 48

Z
Zone System 38
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